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This document contains important safety information. Read this document before
attempting to install or use the Chirascan V100. Failure to do so could result in death or
serious injury.
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Use of this Document

1 Use of this Document

This document is intended to inform the operator of the Applied Photophysics Chirascan V100 on its
design, installation and operation.

Some of the items that may be supplied with the instrument are manufactured by external companies,
and are supplied with separate user manuals provided by those companies. The operator should be
familiar with the contents of those manuals, and, in particular, with the safety and hazard information
contained in them.

The Chirascan V100 is an accessory for the Chirascan V100, and this document should be used in
conjunction with the Chirascan V100 user manual. It is assumed that the user of this document is
familiar with the operation of the Chirascan V100 and with Applied Photophysics’ Chirascan software. In
particular, it is assumed that the user is familiar with the hazards associated with the operation of the
spectrometer, and has read the safety information contained in its user manual.

The information in this document is subject to change without notice and should not be construed as a
commitment by Applied Photophysics, who accept no responsibility for errors that may appear herein.
This document is believed to be complete and accurate at the time of publication, and in no event shall
Applied Photophysics be held responsible for incidental or consequential damages with or arising from
the use of this document.

COPYRIGHT © 2023 APPLIED PHOTOPHYSICS LIMITED. ALL RIGHTS RESERVED. THIS
DOCUMENT OR PARTS THEREOF SHALL NOT BE REPRODUCED IN ANY FORM WITHOUT THE
WRITTEN PERMISSION OF THE PUBLISHER. 

THE SOFTWARE PROVIDED WITH THE CHIRASCAN V100 AND ITS ACCESSORIES (CHIRASCAN
CONTROL, CHIRASCAN VIEWER ETC.) IS THE PROPERTY OF APPLIED PHOTOPHYSICS LIMITED
AND IS SUPPLIED UNDER LICENSE. APPLIED PHOTOPHYSICS IS WILLING TO LICENSE THE
SOFTWARE ONLY UPON THE CONDITION THAT THE LICENSEE ACCEPTS ALL THE TERMS
CONTAINED IN THE LICENCE AGREEMENT. THESE INCLUDE THAT THE LICENSEE MAY NOT
SELL, RENT, LOAN OR OTHERWISE ENCUMBER OR TRANSFER LICENSED SOFTWARE IN
WHOLE OR IN PART TO ANY THIRD PARTY. FOR A FULL COPY OF THE LICENCE PLEASE
CONTACT APPLIED PHOTOPHYSICS OR SEE THE SOFTWARE INSTALLATION DISK.

Applied Photophysics makes every effort to ensure the functionality and stability of its software and
reserves the right to make changes or improvements to the software at any time without notice. Applied
Photophysics cannot be held responsible for any errors in, omissions or loss of data as the result of:
system malfunctions arising from power or hardware failures; errors or omissions in this user manual; or
user action beyond what is described in this user manual. The latter includes but is not limited to: failing
to establish regular data backups and failing to secure the data externally. Moreover, Applied
Photophysics accepts no liability for the interpretation of data measured with its instruments or the
outcome of such interpretation.

Software version numbers and appearance of operating system or graphical user interfaces displayed in
screenshots may not always correspond to the currently released software version or the user’s
operating system. However, all screenshots show the content related to the functions that they are
supposed to illustrate.

This document refers to ANMS 2.0.2 and the Chirascan software suite 4.8.3.0.

This document does not replace older document versions; users are advised to keep the document
version received upon installation of the instrument, as deprecated software and/or hardware functionality
might not be reflected in current document versions.
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Chirascan is a trademark of Applied Photophysics Limited.
All other trademarks or registered trademarks are the sole property of their respective owners.
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Use of this Document

1.1 Hazards and Other Indicators

HAZARD INDICATORS USED IN THIS DOCUMENT

The sign to the left is used to indicate a hazardous situation, which, if not
avoided, could result in death or serious injury.

The sign to the left is used to indicate a hazardous situation, which, if not
avoided, could result in minor or moderate injury.

OTHER INFORMATORY INDICATORS USED IN THIS DOCUMENT

The sign to the left is used to indicate a situation which, if not avoided, could
result in damage to the instrument, incorrect data or loss of data.

HAZARD INDICATORS USED ON THE SPECTROMETER OR ITS ACCESSORIES

Note that these hazard indicators may be either colored as below or black and white and indicate the
presence of a hazard that is either described by text accompanying the sign or in this user manual.

The sign to the left is a general hazard indicator.

The sign to the left indicates risk of electricity / high voltage.

The sign to the left indicates risk of optical radiation / UV radiation.

The sign to the left indicates risk of hot surfaces / high temperatures.

1.2 Hyperlinks and References

The electronic version of this document contains hyperlinks between references (including the Table of
Contents and references to Sections in the text) and sources. Left-click to follow a link. Hyperlinks in the
text are indicated by underlined blue  font.

Elements and terms from the Windows operating system or the Chirascan software that are referred to
as they appear in the graphical user interface are indicated in bold font.

Arrows (→) indicate the selection of a sub entry in a menu.

11
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Use of this Document

1.3 Glossary

The following abbreviations are used in the descriptive text in this user manual:

ANMS Active Nitrogen Management System
APD Avalanche photodiode
AU Absorbance units (dimensionless)
CD Circular dichroism
CP Circularly polarized
DC Direct current
LAAPD Large area avalanche photodiode
HT High tension – the same as high voltage
HV High voltage – the same as high tension
L-CP Left-handed circularly polarized
LED Light-emitting diode
PEM Photoelastic modulator
R-CP Right-handed circularly polarized
SCP Spectrometer control panel
S/N Signal-to-noise ratio
UV Ultraviolet
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Essential Safety Information

2 Essential Safety Information

MAKE SURE THAT YOU HAVE READ AND UNDERSTOOD ALL THE SAFETY INFORMATION
CONTAINED IN THIS DOCUMENT, AS WELL AS ANY DOCUMENTATION BY THIRD-PARTY
MANUFACTURERS SUPPLIED WITH THE INSTRUMENT, BEFORE ATTEMPTING TO INSTALL OR
OPERATE THE CHIRASCAN V100. IF YOU HAVE ANY QUESTIONS REGARDING THE OPERATION
OF THE SPECTROMETER, PLEASE CONTACT APPLIED PHOTOPHYSICS CUSTOMER SUPPORT.

OBSERVE ALL SAFETY LABELS AND NEVER ERASE OR REMOVE SAFETY LABELS.

PERFORMANCE OF INSTALLATION, OPERATION, OR MAINTENANCE PROCEDURES OTHER
THAN THOSE DESCRIBED IN THIS USER MANUAL MAY RESULT IN A HAZARDOUS SITUATION
AND WILL VOID THE MANUFACTURERS WARRANTY.

The Chirascan V100 is powered by the mains electricity supply which can
produce an electric shock leading to serious injury or death. Do not connect or
disconnect electrical leads to the mains supply unless the supply is powered
off at source. Exercise care during operation and do not operate units with
their covers removed. In the case of emergency, switch off the system at
mains power outlet / switchboard. For reconfiguration or maintenance, switch
off the system power supply unit before disconnecting any cables.

Ensure all communications and electrical connections are made and any
jackscrews (if present) are tightened before powering on the spectrometer.
Operate the spectrometer using only the cables provided. Never operate a
spectrometer or any peripherals such as the Peltier controller with damaged
cables.

The metal components of the spectrometer can produce an electric shock
leading to serious injury or death if they are not earthed (grounded). The
design of the spectrometer provides protection against electric shock by
earthing appropriate metal components. This protection will be lost unless the
power cable is connected to a properly earthed outlet. It is the user’s
responsibility to ensure that a proper earth connection can be made.

Detectors of the Chirascan V100, including the avalanche photodiode (APD)
detector, operate at high voltages and can produce an electric shock leading
to serious injury or death. Do not connect or disconnect the detector from the
spectrometer unless the spectrometer is powered off. Do not allow any item to
come into contact with the front end of the detector while the detector is
connected and powered up, as this may cause an electrical short leading to
serious injury to the user and damage to the detector.
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The light source of the Chirascan V100 is a 150-watt xenon or mercury-xenon
arc lamp that produces intense UV radiation that can be harmful to skin and
eyes and may even impair eyesight permanently. Do not allow the skin to be
exposed to UV radiation. Never look directly at the light source. Do not power
on the lamp unless it is correctly mounted in the lamp housing. Do not remove
the lamp system cover and do not open the lamp housing while the lamp is
operative, as indicated by the yellow lamp system cover indicator. Do not
attempt to remove the UV filter of the lamp housing port. Do not attempt to
remove the Single Cell Peltier Holder or any accessory that replaces it unless
the lamp is powered off or the lamp shutter is closed.

Xenon arc lamps have a high internal pressure and can burst, particularly when
hot, causing injury to the user and bystanders. Do not open the lamp housing
immediately after it is powered off. Handle carefully, do not submit the lamp to
shock, and wear eye, full face (shield / visor), and body protection, including
full arm covering. Do not touch the glass bulb of the lamp with bare hands.
When handling lamps, ensure that others are restricted from entering the area
or wear protective personal equipment as well. If not installed, always store
and transport lamps (old or new) only in safety metal cases provided by
Applied Photophysics to guard against implosion.

 
Upon normal operation, the Chirascan V100 is purged with nitrogen gas, which
can act as an asphyxiant—high levels of nitrogen gas in the operation
environment may cause hazard due to oxygen depletion (atmospheric
concentration below 19.5%). Therefore, safety measures (i.e., ventilation,
oxygen monitoring etc.) that take into account site-specific constraints (e.g.,
room size, altitude, experimental regimen etc.) must have been established
upon commissioning of the system (on-site risk assessment) and be
continuously maintained to ensure safe oxygen levels. It is highly
recommended to operate an oxygen monitoring device in close proximity to
the instrument at all times where risk of oxygen depletion is evident, and it is
the user's responsibility to ensure that any operators of the Chirascan V100
understand function of such a device. If nitrogen purging must be stopped in
case of emergency (e.g., if ventilation cannot be maintained), nitrogen flow
must be cut off by closing the mains gas outlet at the operation site.

Depending on the target measurement temperature, the Single Cell Peltier
Holder, cuvette holder and cuvette may be very hot or cold, causing injury to
the user when touched. Ensure that they have been allowed to reach a safe
temperature before handling or use protective equipment (e.g., thermally
protective gloves) if their insertion or removal at extremely high or low
temperature is required. Always use the provided plastic lid for the cuvette
holder  to avoid accidental contact with its top surface if hot. Carry out risk
assessment and consider additional personal protective equipment if in doubt.

50
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Essential Safety Information

Depending on system configuration and experiment design, target

measurement temperature can reach between -20°C and 150°C. Extra care

should be taken when handling a potentially hot/cold cuvette as the target

measurement temperature is actively set through computer control and
monitored only via the Peltier controller display or the control software. As
unsafe temperatures cannot be identified otherwise (e.g., after hard- and
software is switched off or fails), the Chirascan V100 may only be used by, or
under supervision of, trained laboratory personnel familiar with this user
manual and the risks associated with usage of the system and related
procedures, particularly when conducting experiments at elevated sample
temperatures.

The lamp is at high temperature during operation. Do not remove outer lamp
system cover while the lamp is on. Surface temperature of the lamp unit
housing exceeds 50°C during operation, imposing risk of burns, DO NOT
TOUCH. After powering off, allow lamp housing temperature to decrease until
cool to touch (at least 30 minutes) before removing the lamp.

The interaction between UV light and oxygen leads to the formation of ozone,
a very reactive gas that is damaging to health and may cause deterioration of
the optical components of the instrument. If an ozone producing lamp is used,
it is essential that the spectrometer is thoroughly purged with nitrogen before
the lamp is powered on.

When changing a lamp, remember that the programmed schedules for the
ANMS will remain active. Do not power on a Xenon or Mercury-Xenon lamp
until the lamp spectrometer has been thoroughly purged.

The Chirascan V100 may only be used by, or under supervision of, trained
laboratory personnel familiar with this user manual and the risks associated
with usage of the system and related procedures. Users are expected to
adhere to local health and safety regulations and wear personal protective
equipment according to good laboratory practice. Operators are expected to
act on local risk assessment that has been carried out in advance. The
system or any of its parts may not be used when tired or under the influence
of alcohol, medication, or other substances that possess a known potential to
impair user capabilities.

The Chirascan V100 must not be used if any displays, indicators (e.g., for
lamp status and sample temperature) or warning devices (e.g., nitrogen alarm
system) are not operable.
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Essential Safety Information

The intended use of the Chirascan V100 is within a laboratory environment for
research and development purposes. As such, samples used for
measurements with the system are usually not yet fully characterized and are
typically biological samples or, less commonly, samples containing volatile
organic solvents. Risk assessment in terms of known and unknown potential
hazards arising from the nature of these samples (e.g., biohazards, corrosion,
flammability etc.) and implementation of suitable safety measures (e.g., usage
of biocides, sealed cuvettes) when operating the instrument with such
samples is the responsibility of the user(s). Applied Photophysics shall not be
liable for any damage to equipment or users arising from inadequate risk
assessment or sample handling by the user(s). For health and safety
information about chemicals, refer to manufacturers and local regulators.

The electronic circuitry used in the spectrometer is very sensitive and must be
correctly earthed (grounded) to avoid electrical interference. It is the user’s
responsibility to ensure that a proper earth connection can be made.

The performance of xenon arc lamps shows some deterioration over time. It is
recommended that the lamp is replaced after 1000 hours of use.

The performance of the nitrogen filter decreases over time as trace organic
impurities are accumulated. It is recommended to replace the filter whenever
the lamp is replaced.

To confirm correct operation of the nitrogen alarm, the system should
occasionally be subjected to a power cycle. This will sound the alarm if it is
functional.

The monochromator of the spectrometer contains computer-controlled moving
parts which may move without warning. The monochromator may only be
accessed by Applied Photophysics personnel and after system power has
been switched off.

Upon reconfiguration of the system, ensure that any parts are being installed
as described, screws tightened, electrical connections fixed with jackscrews
(if applicable), and gas fittings secured.

The spectrometer has components than can be damaged if their movement is
not restricted when the spectrometer is moved. Please contact  Applied
Photophysics if you wish to move the spectrometer.

Corrosive chemicals and organic solvents can cause damage to the
spectrometer. Do not allow corrosive fluids to come into contact with any part
of the spectrometer. Do not clean the spectrometer with organic solvents. Use
only a soft cloth and water or a mild detergent solution. It is good practice to
load the sample into the cuvette before the cuvette is installed in the cuvette
holder.

Quartz glass cuvettes are typically used with the instrument and should be
handled with care. Make sure not to use damaged or chipped cuvettes and
follow local guidelines for safe handling of laboratory glassware.

147
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Installation and Operational Requirements

3 Installation and Operational Requirements

Environmental requirements
The Chirascan V100 is best installed in a safe position, in a clean, air-conditioned, and well-lit laboratory
environment. Installation must be close to the facility’s mains power and nitrogen gas outlet as it must
be possible to quickly isolate the instrument from mains power or gas supply in case of emergency.

Operating conditions
Temperature: 20°C to 25°C controlled to within 1.5°C
Humidity: 20% to 80% non-condensing
Dust levels: minimum

Storage conditions
Temperature: -20°C to +50°C
Humidity: 5% to 80% non-condensing

Bench space
The total bench space required for the Chirascan V100 including Single-Cell Peltier Controller and
computer is:

Length × depth × height: 2.2 × 0.8 × 0.6 meters

Some accessories may require additional space. Additional space is also required below the bench for
the water circulator.

A flat, stable, and vibration-free work surface which is sturdy enough to support the total bench weight of
the system is required. In regions prone to seismic activity, it is recommended that the system is
tethered. If the latter is necessary, please contact  Applied Photophysics Customer Support.

Weights
Spectrometer lift weight*: 84 kg
Spectrometer bench weight: 108 kg
Total bench weight**: 110 kg

*without lamp housing cover and sample chamber
**includes Peltier controller, does not include computer

Electrical requirements
The Chirascan V100 is supplied with a filtered mains distribution board which requires an earthed
(grounded) mains electricity supply of between 85 and 285 VAC 50/60 Hz, 1000 W maximum.

Nitrogen purge gas
Unless used with a non-ozone producing lamp, the Chirascan V100 requires constant purging with
99.998% oxygen free nitrogen at a pressure of 4 to 6 bar (60 to 90 psi) and flow rate of at least 5 liters
per minute. 

Fluid circulator unit
The fluid circulator supplied as standard with the Chirascan V100 is a CW-3000 Industrial Chiller which
operates at a water pressure within the range (0.2 to 1.7 bar) required by the Single Cell Peltier Holder
(Quantum Northwest). The circulator should be placed on the floor, close to the spectrometer.
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4 General Information

Computer configuration
The Chirascan V100 is normally supplied with a PC pre-configured for use with the instrument. However,
there are some issues that you need to be aware of, described below.

Administrator login
No password is set by Applied Photophysics for the Administrator account. Customers are advised to
set the Administrator password of the Chirascan PC themselves.

Applied Photophysics Service Account
The user account “APLService” has been created and given administrative privileges by Applied
Photophysics. This account will be used by Applied Photophysics' engineers during servicing of your
spectrometer. Do not remove this user, or change the password.

Chirascan User Login and the Chirascan Users Group
The user account “Chirascan User” has also been created by Applied Photophysics. Chirascan V100
users may log in as “Chirascan User”, or the system administrator may create individual user accounts.
A “Chirascan Users” group has also been created, and users should be made members of this group. If
the Chirascan PC is connected to a network then this may affect the way in which users log on to the
Chirascan PC. The system administrator should ensure that “network” or “domain” users who want to
use the Chirascan software are members of the “Chirascan Users” group.

Virus protection

The Chirascan PC may be supplied with a trial version of a 3rd party anti-virus package. Applied
Photophysics recommends that the Chirascan PC has up-to-date anti-virus software installed at all
times. Most users will have a preferred anti-virus software package, and Applied Photophysics generally
recommends that the anti-virus software which is supported by the users' ICT department be installed on
the Chirascan PC. However, please see the note on installing 3rd Party software below.

Networking
The Chirascan PC is supplied with networking capabilities. However, before the Chirascan PC is
connected to a network, the System Administrator should ensure that appropriate anti-virus (and
optionally anti-spyware) software is installed and maintained. Applied Photophysics cannot be held
responsible for failure of the Chirascan PC due to viruses or other malware.

Installation of 3rd Party Software
The Chirascan software suite is not compatible with most 3rd party firewall programs, including Norton,
McAfee and Sophos firewall programs. The software suite is compatible with Microsoft Windows built-in
firewall, provided that Chirascan software is listed as an exception. Applied Photophysics is not aware of
any other conflicts with 3rd Party Software and will not be held responsible for failure of the Chirascan
software because of any such conflict. 

Upgrading Software and/or Hardware
The Chirascan software has been developed for use with Microsoft Windows software and has been
extensively tested on the PCs supplied by Applied Photophysics. Applied Photophysics cannot be held
responsible for failure of the Chirascan software if the Chirascan user or system administrator upgrades
the PC, or the PC's Operating System.

Technical Support and Licensing
Applied Photophysics will provide technical support, under the terms of the Service Level Agreement, for
the software, subject to the Chirascan Software License, and for the supplied PC. However, Applied
Photophysics cannot be held responsible for failure of the software or hardware through misuse or
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neglect by the user, nor can Applied Photophysics be held responsible for loss of data. It is the sole
responsibility of the user to ensure that data is backed up and that a disaster recovery plan is in place.

If you have any queries relating to the software or PC, please contact  Applied Photophysics
Customer Support.

Servicing
Servicing of the Chirascan V100 and its peripherals or accessories should only be undertaken by
qualified personnel. If you are in any doubt at all please contact  the Applied Photophysics Customer
Support.

147

147



Introduction

2323



24

Chirascan V100 User Manual 
 
                                                                                                                    © 2023 Applied Photophysics Limited

Introduction

5 Introduction

This Chapter contains a brief introduction to the Chirascan V100, its hardware, software and operation. It
also describes the basics of making a good Circular Dichroism (CD) measurement.

5.1 The Chirascan V100

5.1.1 The Spectrometer Hardware

Figure 1: The Chirascan V100 spectrometer

The Chirascan V100 (Figure 1) is designed for performance and versatility, allowing it to make high
quality CD or other measurements with a broad range of accessories.

The Chirascan V100 comprises three main sections : the lamp housing on the left, the
monochromator and electronics in the center, and the sample chamber on the right.

In its standard configuration, the spectrometer uses a Single Cell Peltier Holder for sample positioning
and temperature control, and that configuration is shown in this user manual. 

More detailed information on the spectrometer Hardware  is given in the corresponding Chapter. A list
of accessories  available for use with the Chirascan V100 is given in a corresponding section; each
accessory has its own user manual.

5.1.2 The Spectrometer Software

The Chirascan V100 software comprises two main programs, Chirascan Control and Chirascan
Viewer . The Active Nitrogen Management System  (ANMS) for monitoring and control of nitrogen
purging runs independently of the Chirascan software.

Acquisition is controlled with Chirascan Control , where measurement settings can be configured,
saved and reopened. Experimental data is saved to Datastores , and is viewed, analyzed, exported
and imported in Chirascan Viewer .
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5.2 Operating Principles

This section gives a short introduction to CD spectroscopy and describes the operating principles of the
Chirascan V100.

5.2.1 Circular Dichroism

Circular dichroism (CD) is the difference in absorbance between left-handed circularly polarized (L-CP)
light and right-handed circularly polarized (R-CP) light and occurs when a molecule contains one or more
chromophores (light-absorbing groups) in chiral environments, i.e.:

CD = ΔA(λ) = A(λ)
L-CP

 - A(λ)
R-CP

(1)

where λ is the wavelength and A is the absorbance. 

Circular Dichroism spectroscopy is a technique where the CD of a sample is measured over a range of
wavelengths. It is used extensively to study chiral molecules of all types and sizes, but it is in the study
of large biological molecules where it finds its most important applications. A primary use is the analysis
of the secondary structure and tertiary structure of macromolecules, particularly proteins. As protein
conformation is sensitive to environment, e.g. temperature, pH, or the presence of ligands, CD can be
used to observe how secondary or tertiary structure changes with environmental conditions or on
interaction with other molecules. Structural, kinetic and thermodynamic information about
macromolecules can be derived from CD spectroscopy.

Measurements carried out in the UV, visible and near infrared regions of the electromagnetic spectrum
monitor electronic transitions, and, if the molecule under study contains a chromophore in a chiral
environment, then one CP light state will be absorbed to a greater extent than the other, and the CD
signal over the corresponding wavelengths will be non-zero.

The spectrometer measures alternately the absorbance of L- and R-CP light, at a frequency of 50 kHz,
and then calculates the CD signal. A CD signal can be positive or negative, depending on whether L-CP
light is absorbed to a greater extent than R-CP light (CD signal positive) or to a lesser extent (CD signal
negative). 

Simultaneously with the CD measurement, the spectrometer can measure the sample absorbance, but
note that, unlike on conventional CD spectrometers, the absorbance measurement is exact, as the
LAAPD detector gain is known precisely. The Chirascan V100 can also be used in direct absorbance
mode  as a single-beam absorbance spectrometer. 

5.2.2 How the Spectrometer Works

The spectrometer scans across a range of wavelengths , from high to low. The wavelength does not
change continuously but is selected step-wise  by the monochromator, with an acquisition being
performed after each step. 

At any step, light with a certain spread in wavelength is allowed to pass through the sample rather than
light of a single wavelength. This spread is the spectral bandwidth . For example, with the
monochromator set to 260 nm and a bandwidth set to 1 nm, the light arriving at the sample will be
between 259.5 and 260.5 nm (approximately – the situation is slightly more complicated than that).

At each step, photons are collected by the detector for a given amount of time, the time-per-point .
After the scan across the specified wavelength range is completed, the scan may be repeated
multiple times with the same settings.
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In summary, the settings that need to be defined for spectral acquisition are the wavelength range, step
size, time-per-point, bandwidth, number of repeats and, usually, temperature.

For example, with the wavelength range set to 260 to 180 nm, the step size to 1 nm, and the time-per-
point to 1 s, the monochromator remains stationary for 1 s for a reading at 260 nm, then it moves to
259 nm for another reading for 1 s, then moves to 258 nm, and so on.

The acquisition settings defined above will give a total of 81 data points, so the nominal acquisition time
will be 81 s. However, the monochromator will spend a little time moving between wavelengths and
acquisition will take slightly longer if the AutoPM  function is enabled (which it is by default), so the
total scan time will be longer than that (about 100 s). Therefore, an approximate scan time is shown on
the Sampling panel  of the spectrometer control panel . If more than one repeat is used, the
acquisition time increases in proportion.
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6 Quick Start

This Chapter describes the basic operation of the Chirascan V100, covering the startup of hardware and
software, functions of the spectrometer   control software essential for setting up and running
measurements, and general features of the data acquisition  software that enable the user to display
CD spectra, perform basic data analysis and export data to formats compatible with third-party
programs.

6.1 Hardware Startup
Main system power

1. Make sure the black rocker switch for the System on the front panel  is in the power on (I)
position.

2. Make sure the black rocker switch for the Lamp on the front panel  is in the power on (I) position.

Nitrogen purging

The spectrometer requires purging with high purity nitrogen gas  before and during use to prevent the
formation of ozone and eliminate oxygen from the light path.

The interaction between UV light and oxygen leads to the formation of ozone,
a very reactive gas that is damaging to health and may cause deterioration of
the optical components of the instrument. If an ozone producing lamp is used,
it is essential that the spectrometer is thoroughly purged with nitrogen before
the lamp is ignited.

1. Make sure that your nitrogen purge gas supply is stocked sufficiently to provide enough nitrogen for
the planned measurements at the default flow rates . Then open the valve of the nitrogen supply.

2. Start the Active Nitrogen Management System (ANMS)  software and click Connect on its main
screen. If required, schedule purging . If the spectrometer has not been used for an extended
period, purge overnight. 

3. Click Start Lamp Ignite Sequence in the Monitor tab; the lamp will be ignited automatically once
the instrument has been purged sufficiently.

4. After ignition, leave the lamp to stabilize for at least 20 min before acquiring data.

Peripherals

1. Turn on the water circulator .
2. Turn on the Peltier controller for the sample chamber .

Always make sure that the water circulator is switched on to remove heat from
the Peltier device. Otherwise, the temperature of its heat exchanger rises until
a certain cut-off value is exceeded and temperature control is automatically
shut down to prevent damage to the unit.

67

99

40

40

42

65

65

66

56

54



29

Chirascan V100 User Manual 
 
                                                                                                                    © 2023 Applied Photophysics Limited

Quick Start

6.2 Software Startup

Before starting any software, make sure that the spectrometer including its peripheral hardware is turned
on .

The programs need to be opened in the following sequence for correct communications to be
established:

 
1. Open Chirascan Control  by double-clicking its desktop icon.

Upon software startup, the instrument automatically checks its zero positions (you may hear the
monochromator motors moving).

2. Open Chirascan Viewer . Chirascan Viewer is launched on-line from the Spectrometer Control
Panel (SCP)  by clicking on the Chirascan Viewer launch icon in the SCP toolbar. 

For viewing and analyzing data only without performing measurements, Chirascan Viewer can also be
launched off-line  by clicking on its desktop icon.

In general, when working at the instrument, it is recommended that Chirascan Viewer is launched from
Chirascan Control using the toolbar icon as this will ensure that local communication is established, that
Chirascan Viewer will work correctly as a real-time display, and that the data will be saved in the
Working Directory .

3. Choose your Working Directory .

All data acquired will be saved in the Working Directory . To set the Working Directory , first
navigate in the Chirascan Viewer file browser and open, or create, a folder for data collection. Then
select the folder of your choice and click on the Set Working Directory toolbar icon. Alternatively, right-
click on the folder of choice and choose Set Working Directory Here or use the Set Working
Directory option on the Directory menu. 

To set file names for background, buffer and sample spectra, click on the File Names icon  in the
toolbar of the SCP  to open the File Names dialog  or select Configuration → Preferences →
File Names to open the File Names tab  of the preferences where seed names and running numbers
(four digits with leading zeroes) can be specified (Figure 2). The file name for the background is set in
the Background input field, the file names for buffer or sample spectra are set in the Spectrum input
field. Note that entering special characters is not allowed.

Figure 2: The File Names dialog
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6.3 Basic Data Acquisition

6.3.1 General Sequence

To make a good CD measurement for a sample, follow the general sequence, which is explained in more
detail in the following subsections.

1. Configure the acquisition settings  as required—some preliminary work may be required to
establish the optimal conditions.

2. Acquire a background . The background enables you to measure the absorbance spectrum of your
buffer and sample.
a. Mount the empty cuvette holder in the Single Cell Peltier Holder, i.e., do not insert a cuvette.
b. Set the file name for the background.
c. Click Background on the Background panel .

3. Acquire a sample CD spectrum . 
a. Load  the cuvette containing sample into the Single Cell Peltier Holder.
b. Set the file name for the sample. 
c. Click Acquire on the Sequencer panel .
d. Check the sample total absorbance. If required, adjust  the absorbance at this point.

4. Acquire a buffer CD spectrum . This gives you the absorbance of the buffer and provides a baseline
CD spectrum, i.e. the spectrum of the buffer that you will later subtract form the sample spectrum.
a. Remove and clean the cuvette and fill with the buffer, reload  the cuvette into the Single Cell

Peltier Holder. 
b. Set the file name for the buffer. 
c. Click Acquire on the Sequencer panel .

If there are doubts about the suitability of the buffer at hand for CD measurements, it might make sense
to measure the buffer spectrum first, of course. In any case, it is important that the total absorbance
of the sample (i.e. including contributions from both buffer and molecule of interest), rather than just that
of the molecule of interest, is known, so that it can be kept within the reasonable working range. Only if
the total absorbance is below about 2 AU, or at most 2.5 AU, are CD spectra of reasonable quality
obtainable. Buffer, water and even heavy water absorb very strongly at wavelengths near and below
180 nm and therefore always contribute to the total absorbance at low wavelengths.
This is why a buffer baseline should always be acquired in a dedicated acquisition separate from the air
background rather than taking a background with the buffer in place. If the latter were done, the
absorbance for subsequent acquisitions would be referenced against the buffer, and an exceeding total
sample absorbance would remain undetected as the apparent sample absorbance would lack any buffer
contribution. In terms of data presentation and publication, only the spectral contribution from the
molecule of interest is usually of ultimate interest. To this end, the buffer baseline is subtracted  from
the sample spectrum.

6.3.2 Configuring Acquisition Settings

The settings for spectral acquisition are set up on the Spectrometer Control Panel  (Figure 3). The
SCP is divided into a number of panels: Signal (with sub-panels Options and Background),
Temperature Control Unit, Sample Chamber, Monochromator, Sampling, Sequencer, and
Progress and Status, which group the parameters relevant for the control or management of each
panel’s function. In addition, there is an unlabeled panel for controlling shutter function and detector
emulated high voltage in the upper right section of the SCP.
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Figure 3: The Spectrometer Control Panel

Configure the settings for spectral acquisition:

1. In the Monochromator panel , choose a wavelength range (Low and High), set the Step size, and
click Set to confirm.

2. In the Monochromator panel , set the Bandwidth and click Set to confirm.
3. In the Sampling panel , set the Time-per-point.
4. In the Temperature Control Unit panel , set the measurement Temperature: click Settings… to

open the Temperature Control dialog , adjust the temperature value, click Set to confirm and click
OK.

5. In the Sequencer panel , tick the Repeats check box. Set the repeats number and adjust other
acquisition settings as required.

6. After configuring the acquisition settings, you can save the configuration by choosing File → Save
as... in the menu.

An existing configuration can be loaded by choosing File → Open… in the menu. Default settings can
be loaded in the SCP by choosing File → New in the menu.

The choice of acquisition settings  depends on sample requirements.

6.3.3 Acquiring a Background

Every CD spectrometer has a CD background, caused by the interaction of CP light with the slight
birefringence found in the detector window and to a lesser extent in the cuvette. To see the true CD
spectrum of your sample, this background must be measured and subtracted from the CD spectrum of
the sample.
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Moreover, meaningful CD data can only be obtained if the total absorbance is within a reasonable range.
To evaluate if this requirement is fulfilled, simultaneous acquisition of CD and absorbance is
recommended. An absorbance reference is required to obtain total absorbance. As water absorbs
strongly at low wavelengths, this reference should be obtained with an empty cuvette holder.

1. Configure  the settings for spectral acquisition of the background.

Note that subsequent acquisitions can have a different wavelength range, step size or bandwidth only if
each data point has a corresponding value in the background. Therefore, a new background must be
taken whenever any of these settings is changed. Alternatively, a background that combines different
wavelength ranges and step sizes can be taken. For example, if you plan to acquire sample spectra in
both the near- and far-UV with step sizes of 0.5 and 1 nm, respectively, acquire a background spectrum
with a step size of 0.5 nm including both ranges.

2. To acquire a CD background together with an absorbance reference, make sure the Absorbance
check box is ticked.

3. If necessary, install the correct cuvette holder  or  adapter for the cuvette to be used. This is
important as different holder  or adapter window sizes affect the amount of light reaching the
detector.

4. Make sure there is no cuvette in the cuvette holder   and click Background in the Background
panel  to acquire a background.

The CD background is measured together with the absorbance reference and a Graphical Display  by
Chirascan Viewer automatically opens and displays the data. The data are stored in the Working
Directory  as a .dsx file, the name of which is generated by a seed name (the default seed name for
background data is ‘Base’) and a running number with leading zeros (e.g., ‘Base0001’). The Auto
Subtraction check box becomes active at the conclusion of a background scan: if you wish to subtract
the CD background automatically from subsequently measured CD spectra, tick the Auto Subtraction
check box.

While an absorbance reference is always required to enable subsequent absorbance measurements,
enabling Auto Subtraction or taking a CD background at all is, in principle, not necessary if the buffer
spectrum is subtracted from the sample spectrum, as is recommended for basic data analysis.
However, always recording the CD background is good practice and can help confirming correct
operation of the instrument. In rare situations where a suitable buffer for baseline measurements is not
available, e.g. due to practical constraints of the application, at least the CD background must be
subtracted from sample spectra. In such cases, using Auto Subtraction might be more convenient than
manual background subtraction. In general, whether Auto Subtraction is used or not, it should be done
consistently so to avoid accidentally subtracting the background twice.

An example of a CD background is shown in Figure 4. 
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Figure 4: Background CD spectrum

6.3.4 Loading the Buffer or Sample

To avoid spillages, the cuvette  is best removed from the cuvette holder before loading. Most samples
can be pipetted into the cuvette. Make sure that there is enough buffer or sample in the cuvette to cover
the window in the cuvette holder, and that there are no bubbles. If the measurement is to be run at high
temperatures, it may be necessary to remove dissolved gas before, to prevent bubble formation. 
 
The cuvette should insert easily into the holder, and is sprung against the face of the holder to ensure
reproducible positioning. Always record the orientation of the cuvette, i.e. which side faces the lamp, so
that it can be replaced in the same orientation; usually, a mark on the cuvette indicating its type helps to
distinguish the two sides.

Figure 5: Inserting the in-sample temperature probe
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If using an in-sample temperature probe  (Figure 5), ensure that the temperature probe is immersed in
the buffer or sample to a depth of a least 2 mm, but is not intruding into the light beam. Finally, close the
lid of the sample chamber.

6.3.5 Acquiring a Sample Spectrum

To perform a sample measurement, follow these steps:

1. Load  the cuvette with sample, place the cuvette in the holder and insert the in-sample
temperature probe  if desired. Don't forget to record the orientation of the cuvette.

2. Set the measurement temperature : click Settings... in the Temperature Control Unit panel .
Then adjust the temperature value in the Temperature Control Dialog , click Set to confirm and
click OK.

3. Tick the Repeats check box in the Sequencer panel . Set the repeats number and configure
other acquisition settings as required.

It is recommended to always acquire repeat scans as these help in identifying baseline drift or sample
photolysis. All remaining parameters, including wavelength range, step size, bandwidth, and time-per-
point, should have already been set for the background.

4. Set the file name for the sample spectrum in the Spectrum input field of the File Names dialog .
5. Let the sample equilibrate until the target temperature displayed in the sample chamber panel  is

reached.
6. Click Acquire in the Sequencer panel  to start acquisition of the sample spectrum.

Chirascan Viewer automatically displays the data as it is collected, and the spectral results will appear
as illustrated by example spectra . When any CD spectrum is acquired on the Chirascan V100, other
properties are simultaneously recorded. These include the voltage applied to the detector, the
temperature, and the absorbance spectrum (if selected on the Options panel ). They can be viewed by
right-clicking on the label of the y-axis in the Graphical Display  and selecting the property of choice
in the context menu.

7. Check that repeat spectra overlay to make sure that the sample does not undergo photolysis and
that there is no baseline drift.

8. Inspect  the corresponding absorbance spectrum: right-click the label of the y-axis in the
Graphical Display  and select Absorbance in the context menu.

9. If the absorbance is too high, reduce the path length or change the sample concentration of buffer to
optimize  the absorbance.

Remember that light intensity at low wavelengths may cause photodegradation of photolabile proteins.
Keep the bandwidth  and the time-per-point  as low as possible, commensurate with obtaining
reasonable quality data. If there is any doubt, repeat the experiment to ensure that the results are
reproducible, or perform a preliminary experiment to establish the timescale over which photodegradation
occurs. 

6.3.6 Acquiring a Buffer Spectrum

To account for the CD signal of a buffer or other solvent, a baseline CD spectrum must be measured on
the buffer without sample. The baseline spectrum should be acquired using the same conditions as are
used for the sample spectrum, including using the same cuvette in the same orientation.

1. Empty and clean the cuvette. Then load it with the buffer.
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2. Place the cuvette with buffer and in-sample temperature probe into the cuvette holder in the same
orientation as used for the sample.

3. Set the file name for the baseline spectrum in the Spectrum input field of the File Names dialog .
4. Let the buffer equilibrate until the target temperature is reached.

As the parameters for the acquisition of the baseline spectrum are identical to those for the sample,
there are no parameters that need to be adjusted at this point.

5. Click Acquire in the Sequencer panel  to start acquisition of the baseline spectrum.

The CD spectrum is recorded under the same conditions as applied to the sample and stored in the
Working Directory  as a file named as specified.

6. Check that repeat spectra overlay to make sure there is no baseline drift.
7. On completion of the measurement, remove the cuvette from the holder for cleaning and re-use.

Depending on the target measurement temperature, the Single Cell Peltier
Holder, cuvette holder and cuvette may be very hot or cold, causing injury to
the user when touched. Ensure that they have been allowed to reach a safe
temperature before handling or use protective equipment (e.g., thermally
protective gloves) if their insertion or removal at extremely high or low
temperature is required. Always use the provided plastic lid for the cuvette
holder  to avoid accidental contact with its top surface if hot. Carry out risk
assessment and consider additional personal protective equipment if in doubt.

Depending on system configuration and experiment design, target

measurement temperature can reach between -20°C and 150°C. Extra care

should be taken when handling a potentially hot/cold cuvette as the target

measurement temperature is actively set through computer control and
monitored only via the Peltier controller display or the control software. As
unsafe temperatures cannot be identified otherwise (e.g., after hard- and
software is switched off or fails), the Chirascan V100 may only be used by, or
under supervision of, trained laboratory personnel familiar with this user
manual and the risks associated with usage of the system and related
procedures, particularly when conducting experiments at elevated sample
temperatures.

6.4 Basic Data Analysis

In the example below, there are six traces (3 repeat baselines and 3 repeat lysozyme spectra). The data
used in this example can be found in the ‘Examples\Lysozyme Spectra’ folder which is installed with the
Chirascan software (the path will depend on the operating system). The example demonstrates how to
average the baseline spectra, average the sample spectra, subtract the average baseline spectrum from
the average sample spectrum, smooth the resulting baseline-corrected sample spectrum and remove the
original data. The end result will show the sample spectrum and its residual (smoothed minus
unsmoothed spectrum).

1. With the Launchpad File List  open, navigate in the usual way until you find the baseline
measurement file and double-click on it.

Chirascan Viewer displays the data contained in the file in a Graphical Display .
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2. Drag-and-drop the sample measurement file onto the Graphical Display  with the baseline
spectra. 

Both baseline and sample spectra are shown in the same Graphical Display .

3. Click on  in the Graphical Display  toolbar to call up the Trace Manipulation dialog  (Figure
6).

Figure 6: Raw data with Trace Manipulation dialog called up

The first three list entries are baseline spectra; the second set of three are the lysozyme spectra.

4. Select the first group of three list entries and click Average.
5. Select the second group of three list entries and click Average.

Two list entries named Average: 0 and Average: 1 with running numbers will be added to the Visible
Traces list and plotted in the display. The first of these will be the average of the baseline spectra, and
the second the average of the sample spectra.
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6. Select the first Average list entry and click Set Baseline.
7. Select the second Average list entry and click Subtract Baseline.

The list entry Subtracted: 0 (baseline-subtracted sample spectrum) will be added to the Visible Traces
list and plotted in the display. 

8. Click Unset Baseline.
9. Select the baseline-subtracted spectrum named Subtracted: 0 and click Remove Others.

The Trace Manipulation dialog will appear as in Figure 7.

10.Click OK to close the dialog.

Note that even when the Trace Manipulation dialog is closed, any removed traces are remembered.
Should you wish to carry out further manipulation, simply re-open the dialog and all the traces will be
listed, whether visible or removed, enabling you to carry on where you left off.

Figure 7: Trace Manipulation dialog after spectrum manipulation

For final presentation, you might want to smooth  spectra. The result of the above manipulation and
subsequent smoothing is shown in Figure 8, with the smoothed and baseline-corrected spectrum of
lysozyme and the smoothing residuals plotted.
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Figure 8: Smoothed and baseline-corrected spectrum of lysozyme (red) and smoothing residuals (cyan)

11.To save  the result, go to File → Save Current Plot… or File → Save Selected Traces… in the
Graphical Display  menu to call up the Save As  dialog.

The results of any manipulation are stored in a new file when saved together with a complete history of
the manipulated traces which can be viewed on the View  menu of the Graphical Display .
Convert  data into other file formats or export  data as desired.
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7 Hardware

This Chapter describes the Chirascan V100 hardware, covering the general layout of the spectrometer,
the electrical and purge gas connections, and the detectors and light sources available and their removal
and replacement and the temperature controller.

7.1 The Spectrometer Layout

Figure 9: The spectrometer layout

The Chirascan V100 consists of three main sections: the lamp housing on the left, the monochromator
with accompanying optics and electronics in the center and a sample chamber and a light sensitive
detector to the right. The lamp housing and monochromator / electronics sections have removable covers
fitted that can be easily removed for servicing and the sample chamber is a self-contained unit that can
easily be removed for transportation or to install the Chirascan Stopped-Flow accessory.

The spectrometer usually uses a 150-watt air-cooled xenon arc lamp as the light source and a solid
state Large Area Avalanche Photodiode (LAAPD) detector, which is both more sensitive and has a
broader wavelength operating range than a conventional detector.

7.2 The Front Panel

The front panel of the spectrometer consists of the lamp panel on the left and the system panel on the
right (Figure 10).
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Figure 10: The front panel, including lamp panel (left) and system panel (right)

The lamp panel contains a black rocker switch for the Lamp power and a red light-emitting diode (LED)
that is illuminated when lamp power is switched on. The lamp panel also contains a counter showing the
Time in hours of lamp operation since the last reset. The counter can be reset to zero by pressing the
Reset button using an object with a diameter of 2 mm. The red Start button on the lamp panel allows to
ignite the lamp if the ANMS  is not used.

The system panel contains a black rocker switch for the System power and a green Status LED that is
illuminated when the instrument is powered on. The system panel also contains red LEDs labelled Tx
and Rx which will illuminate when commands are being transmitted or data is being received,
respectively.

System and lamp can be kept switched on permanently. These instrument components can be switched
on and off independently, e.g. the system can be switched off for changing accessories while the lamp
remains switched on.

As the ANMS  is usually used to control lamp ignition, the lamp power switch should be switched on
at all times during normal operation and only be switched off for maintenance purposes such as lamp
replacement .

7.3 Electrical Connections

The Chirascan V100 is powered by the mains electricity supply which can
produce an electric shock leading to serious injury or death. Do not connect or
disconnect electrical leads to the mains supply unless the supply is powered
off at source. Exercise care during operation and do not operate units with
their covers removed. In the case of emergency, switch off the system at
mains power outlet / switchboard. For reconfiguration or maintenance, switch
off the system power supply unit before disconnecting any cables.

Ensure all communications and electrical connections are made and any
jackscrews (if present) are tightened before powering on the spectrometer.
Operate the spectrometer using only the cables provided. Never operate a
spectrometer or any peripherals such as the Peltier controller with damaged
cables.
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The metal components of the spectrometer can produce an electric shock
leading to serious injury or death if they are not earthed (grounded). The
design of the spectrometer provides protection against electrical shock by
earthing appropriate metal components. This protection will be lost unless the
power cable is connected to a properly earthed outlet. It is the user’s
responsibility to ensure that a proper earth connection can be made.

The electronic circuitry used in the spectrometer is very sensitive and must be
correctly earthed (grounded) to avoid electrical interference. It is the user’s
responsibility to ensure that a proper earth connection can be made.

The spectrometer has three electronics units mounted above the monochromator. When viewed from the
rear of the spectrometer with the back panel removed, the lamp electronics unit is to the right, the
monochromator electronics unit to the left, and the ANMS  unit is above. Each unit requires a mains
electricity supply at the local voltage. Figure 11 shows the mains connections from the rear of the
spectrometer (the spectrometer back cover has been removed for clarity).

Figure 11: Rear of the spectrometer showing the three mains connections

7.4 Nitrogen Purging

The interaction between UV light and oxygen leads to the formation of ozone,
a very reactive gas that is damaging to health and may cause deterioration of
the optical components of the instrument. It is essential that the spectrometer
is thoroughly purged with nitrogen before the lamp is powered on.

Upon normal operation, the Chirascan V100 is purged with nitrogen gas, which
can act as an asphyxiant—high levels of nitrogen gas in the operation
environment may cause hazard due to oxygen depletion (atmospheric
concentration below 19.5%). Therefore, safety measures (i.e., ventilation,
oxygen monitoring etc.) that take into account site-specific constraints (e.g.,
room size, altitude, experimental regimen etc.) must have been established
upon commissioning of the system (on-site risk assessment) and be
continuously maintained to ensure safe oxygen levels. It is highly
recommended to operate an oxygen monitoring device in close proximity to
the instrument at all times where risk of oxygen depletion is evident, and it is
the user's responsibility to ensure that any operators of the Chirascan V100
understand function of such a device. If nitrogen purging must be stopped in
case of emergency (e.g., if ventilation cannot be maintained), nitrogen flow
must be cut off by closing the mains gas outlet at the operation site.
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In its standard setup, the flow of nitrogen purge gas to the Chirascan V100 is controlled by the Active
Nitrogen Management System (ANMS). It monitors purge gas flow, sets optimal flow rates, and reduces
overall purge gas consumption by allowing for scheduled purging. If your spectrometer has an older
setup without ANMS, please consult its original manual.

By purging the system with nitrogen, oxygen is excluded from the spectrometer. This is important
because the xenon arc lamp used with the spectrometer emits high intensity UV light which interacts
with oxygen to form ozone (Equation 2).

3O
2(g)

 + uv → 2O
3(g)

(2)

Ozone is a highly reactive gas that is damaging to health and to the optical components of the
spectrometer. It has a strong and broad absorbance peak at about 250 nm, and a further broad peak at
about 600 nm, so it attenuates the light from the spectrometer lamp across a large part of its wavelength
range, particularly in the UV region. 

Purging the sample chamber completely after it has been left unpurged is a
slow process. Therefore, it is recommended to purge overnight if the system
has not been in use for an extended period. Insufficient purging of the sample
chamber can result in an absorbance artefact at wavelengths below 200 nm,
which disappears over time with continued purging.

When a sample is placed into the sample chamber, inevitably a small quantity of air will be introduced to
the low-volume light path within the chamber. It takes only a few seconds to re-establish an air-free
environment and you should not need to wait longer than that before starting a measurement.

Purging with low-purity nitrogen may introduce oxygen to the system and thus
fail in eliminating the detrimental effects of ozone formation. Usage of low-
quality nitrogen may result in contamination of the system with organic
impurities or humidity. Never use the system without the filter installed.

The nitrogen should be 99.998% pure (which corresponds to 20 ppm of gaseous contaminants, or grade
N5.0 or higher), and may be supplied by a cylinder, Dewar, or nitrogen generator, and should be
regulated to 4 to 8 bar (58 to 116 psi). The connection to the spectrometer is through the 6-mm diameter
white tubing supplied with the spectrometer, which connects at the rear of the spectrometer. This
regulator is set to 4 bar (58 psi), and this setting should not be altered. 

It is also essential that the nitrogen used to purge the instrument is clean. Any trace organic impurities
from the nitrogen supply could deposit on the internal optical surfaces of the spectrometer and, thus,
need to be removed from the nitrogen stream. To this end, a combined molecular sieve (13×) and
activated charcoal filter is integrated in the instrument. It is recommended that this filter is replaced
whenever the lamp is replaced. Figure 12 shows the main components of the nitrogen purge gas flow
(the spectrometer front cover has been removed for clarity).

To allow for purging of the system, the instrument must be connected to an
external nitrogen supply. As pressurized nitrogen jets may cause injuries to
skin, eyes, and ears, and propel objects, care must be taken to avoid potential
harm due to high pressure release (e.g., regular inspection of pipework and
fittings). A valve must be installed close to the instrument allowing quick shut-
off of flow from the external nitrogen supply in the case of an emergency (e.g.,
if ventilation cannot be maintained and there is increased risk of oxygen
depletion).
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After passing through the filter, the nitrogen enters a solenoid box, which is split three ways. Each outlet
of the solenoid box leads to a solenoid fitted with a flow meter and from there the nitrogen is taken in
washed steel tubing to the three purge inlet ports on the spectrometer, at the lamp housing, the
monochromator and the sample chamber.

Figure 12: Components of the nitrogen purge gas flow

As the ANMS  software is usually used to control lamp ignition, the lamp power switch on the front
panel  should be on at all times. Note that the Start button on the front panel allows for lamp ignition if
the ANMS is not used.

The Chirascan V100 must not be used if any displays, indicators (e.g., for
lamp status and sample temperature) or warning devices (e.g., nitrogen alarm
system) are not operable.

To confirm correct operation of the nitrogen alarm, the system should
occasionally be subjected to a power cycle. This will sound the alarm if it is
functional.

Insufficient nitrogen flow to the system (e.g., if the external nitrogen supply runs out) will be detected and
raise an audible alarm which will be active for 10 min. If adequate nitrogen flow cannot be restored within
this grace period, the lamp will automatically be shut off to prevent harm due to prolonged ozone
formation.

7.5 Light Source

The light source of the Chirascan V100 is a 150-watt xenon or mercury-xenon
arc lamp that produces intense UV radiation that can be harmful to skin and
eyes and may even impair eyesight permanently. Do not allow the skin to be
exposed to UV radiation. Never look directly at the light source. Do not power
on the lamp unless it is correctly mounted in the lamp housing. Do not remove
the lamp system cover and do not open the lamp housing while the lamp is
operative, as indicated by the yellow lamp system cover indicator. Do not
attempt to remove the UV filter of the lamp housing port. Do not attempt to
remove the Single Cell Peltier Holder or any accessory that replaces it unless
the lamp is powered off or the lamp shutter is closed.
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Xenon arc lamps have a high internal pressure and can burst, particularly when
hot, causing injury to the user and bystanders. Do not open the lamp housing
immediately after it is powered off. Handle carefully, do not submit the lamp to
shock, and wear eye, full face (shield / visor), and body protection, including
full arm covering. Do not touch the glass bulb of the lamp with bare hands.
When handling lamps, ensure that others are restricted from entering the area
or wear protective personal equipment as well. If not installed, always store
and transport lamps (old or new) only in safety metal cases provided by
Applied Photophysics to guard against implosion.

The lamp is at high temperature during operation. Do not remove outer lamp
system cover while the lamp is on. Surface temperature of the lamp unit
housing exceeds 50°C during operation, imposing risk of burns, DO NOT
TOUCH. After powering off, allow lamp housing temperature to decrease until
cool to touch (at least 30 minutes) before removing the lamp.

The Chirascan V100 must not be used if any displays, indicators (e.g., for
lamp status and sample temperature) or warning devices (e.g., nitrogen alarm
system) are not operable.

While health and safety information in this user manual covers important
provisions related to operation of xenon lamps with the Chirascan V100, the
user must refer to the lamp manufacturer's guidance and safety instructions for
complete understanding of risks and dangers associated with such lamps and
required precautions.

The standard light source used with the spectrometer is an air-cooled, 150-watt xenon (Xe) arc lamp.
The low wavelength radiation produced by this lamp is responsible for the conversion of oxygen to ozone,
and the lamp should only be used with nitrogen purging. This lamp is not suitable for use with the
Chirascan Stopped-Flow accessory.  The lamp housing includes a port fitted with a UV filter that
connects by a light guide to the lamp system cover indicator, which emits yellow light when the lamp is
installed and lit, and lamp status is displayed in the Manual Display and Control  screen of the ANMS
software.

Two other  lamps are available for the Chirascan V100:

· Mercury-xenon (Hg-Xe) lamp. A mercury-xenon lamp is preferred to the standard xenon lamp for
use with the Chirascan Stopped-Flow accessory owing to its greater stability and higher output at
specific wavelengths. The lamp housing indicator emits green light when this lamp installed. The low
wavelength radiation produced by this lamp is responsible for the conversion of oxygen to ozone, and
this lamp should only be used with nitrogen purging. For more information on the use of this lamp, see
the Stopped-Flow accessory user manual.
· Ozone-free xenon lamp. A non-ozone producing xenon lamp is also available. The lamp housing

indicator emits yellow light when this lamp installed. The low wavelength radiation responsible for the
conversion of oxygen to ozone is filtered from the lamp output, removing the need for nitrogen purging,
but limiting the low wavelength end of the range of the lamp to about 230 nm.
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Mercury-xenon lamps contain several milligrams of mercury, which can be
harmful upon acute exposure. Inhalation of elemental mercury may cause
respiratory, central nervous system, and cardiovascular effects, renal damage,
and gastrointestinal disturbances. Should the lamp break while hot, ensure
that all personnel leave the surrounding area at once, then ensure thorough
ventilation of the area and prevent access to the area until safe re-entry is
possible. In case of cold lamp rupture, remove mercury spills with adhesive
tape or paper, or using a syringe, transfer waste into a container for disposal
and seal tightly. Mercury is considered toxic and, therefore, mercury-xenon
lamps must be treated as hazardous waste and be disposed of in accordance
with local regulations. 

The performance of xenon arc lamps shows some deterioration over time. It is
recommended that the lamp is replaced after 1000 hours of use.

The housing is designed for the lamp to be easily removed and replaced , without the need for
realignment or refocusing. The spectrometer lamp panel  contains a counter showing the number of
hours of lamp operation which should be reset when the lamp is exchanged for a new one.

If it is intended to swap between lamps, for example when changing to or from operation with a
Chirascan Stopped-Flow accessory, a record should be kept of the number of hours for which each lamp
is in use.

7.6 Detector

The large area avalanche photodiode (LAAPD) detector supplied with the
Chirascan V100 operates at high voltages and can produce an electric shock
leading to serious injury or death. Do not connect or disconnect the detector
from the spectrometer unless the spectrometer is powered off or detector high
voltage is set to zero via the Zero HV button in the shutter / attenuator panel
of the Chirascan Control SCP.

Never operate the lamp of the Chirascan V100 with an open CD detector port.
If the detector must be removed, e.g., for replacement, shut off the lamp
beforehand. If the CD detector is not required during system operation, e.g., if
exclusively fluorescence measurements are carried out, the CD detector port
must be blanked off using the blanking plate provided.

The Chirascan V100 uses a large area avalanche photodiode (LAAPD) for CD detection with an operating
range from below 163 nm to 1150 nm. The CD detector is mounted on the transmission port in line with
the light beam and a fluorescence accessory  (optional) can be installed on the port perpendicular to
the beam. The CD detector can easily be replaced  for another one as required for certain
accessories.
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7.7 The Sample Chamber

Detectors of the Chirascan V100, including the avalanche photodiode (APD)
detector, operate at high voltages and can produce an electric shock leading
to serious injury or death. Do not connect or disconnect the detector from the
spectrometer unless the spectrometer is powered off. Do not allow any item to
come into contact with the front end of the detector while the detector is
connected and powered up, as this may cause an electrical short leading to
serious injury to the user and damage to the detector.

Disconnecting electrical components without powering off the spectrometer
can cause damage to the components. Power off the spectrometer before
removing any accessories or electronic peripherals such as a Peltier
controller, or installing the Chirascan V100.

A drain hole is located at the bottom of the sample chamber which prevents
liquid buildup in the case of leakage from the water circulation tubing inside
the sample chamber. Should this unlikely event occur, switch off the water
circulator, turn off the spectrometer using the System rocker switch on its
front panel, and let the sample chamber drain completely. Do not use the
instrument again before the sample chamber is completely dry and the faulty
water circulation tubing has been replaced.

The spectrometer sample chamber is the lidded chamber that mounts to the right of the monochromator
unit, where it is held in place by three thumbscrews and one socket head screw. Normally, the sample
chamber is not removed from the spectrometer, although this can easily be done  for transportation or
to install the Stopped-Flow accessory. For some accessories, the interior of the sample chamber must
be cleared as described  before the accessory can be installed.
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Figure 13: The interior of the sample chamber without Single Cell Peltier Holder, detectors, or
accessories

The interior of the sample chamber, without the Single Cell Peltier Holder or any detector(s) or
accessory installed, is shown viewed from the top with the lid raised in Figure 13 (the aperture for light
inlet from the monochromator is to the left, opposite the CD detector port).

There are two detector ports on the sample chamber, to the right and rear. Normally the right port is
used for CD and the rear port for fluorescence, which must be blanked off with a blanking plate as in
Figure 14 if not in use. The purge gas inlet is to the left upper rear, the circulating fluid connectors to the
right lower rear, and the electrical and additional temperature probe connectors are above the circulating
fluid connectors. The positions of these connections at the rear of the sample chamber are shown in
Figure 14.

On the right upper front within the sample chamber is a lid open sensor; when the lid is raised, no
experiment can be started and any experiments that are in progress will be paused, and the high voltage
of the CD detector is turned off.
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Figure 14: The rear of the sample chamber

For some accessories, additional connections must be routed from the outside into the sample
chamber. For this purpose, a bulkhead plate is mounted to the interior of the right sample chamber wall,
next to the CD detector port (Figure 15). For normal operation of the Chirascan V100 and most of its
accessories, there is no need for exchange of the bulkhead plate. Replacement of the standard bulkhead
plate by a modified plate is only required for operation with or switching between some accessories.

 
Figure 15: Location of the standard sample chamber bulkhead plate as seen from the inside (left) and
from the outside (right) of the sample chamber

7.7.1 The Single Cell Peltier Holder

The Chirascan Single Cell Peltier Holder system consists of two main components: the Single Cell
Peltier Holder and a separate control module  for temperature control.54
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Figure 16: The Single Cell Peltier Holder

The Single Cell Peltier Holder mounts into the sample chamber, and is designed to be easily installed
and removed . It accepts rectangular cuvettes or short-path length circular cells, which mount into
exchangeable cuvette holders . 

Ensure that the threaded spacer connecting monochromator with Single Cell
Peltier Holder and the detector cowling connecting Single Cell Peltier Holder
with detector are in place before igniting the lamp, as otherwise there is risk of
exposure to UV light.

An integral magnetic stirrer  is included in the unit which allows the use of magnetic stir bars with
suitable cuvettes (i.e., 10-mm path length cuvettes), as well as a Peltier element for sample temperature
control . Two quick-fit connectors at the holder base connect to a water circulator  for removal of
excess heat produced by the Peltier element. A communications cable connects to the Peltier control
module . The inlet for nitrogen purge gas  is located at the rear of the holder base. The rear of the
holder wall contains a slit that enables connection to a CCD Emission Fluorometer  that can be
installed in the fluorescence detector port  of the sample chamber.

The Single Cell Peltier Holder and control module are calibrated as a pair; the
holder should only be used with the control module indicated by the serial
number on the rear.

7.7.2 Cuvette Holders

Four standard cuvette holders are available for use with the Single Cell Peltier Holder: 10 mm, 4 mm,
1 mm and Double-Necked Cylindrical. A 10-mm cuvette holder is shown in Figure 17. This holder holds
standard 10 × 10 mm cuvettes and cuvette adapters with outside dimensions of 12.5 × 12.5 mm.
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Figure 17: 10-mm cuvette holder

The cuvette holders are designed to be easily installed and removed, but to be held firmly in place so
that they do not move while the cuvette is being loaded. They must also return the cuvette to the same
position reproducibly, whenever it is removed and replaced. This is particularly important for CD work, as
changes in the cuvette position can affect the CD response. To this end, a metal clip is used to push the
cuvette or adapter into one of the corners of the holder.

The cuvette holder mounts into the Single Cell Peltier Holder with the beam mask facing away from the
detector (note that the cuvette holder is sprung against a face of the Single Cell Peltier Holder to ensure
reproducible positioning). To secure the cuvette holder, tighten the two retaining screws using the narrow
blade screwdriver provided.

To remove the cuvette holder, undo the retaining screws and lift the holder clear. Removing the holder
with the cuvette in place can be useful for checking if enough sample is in the cuvette (i.e. the sample
meniscus cannot be seen when looking through the transmission window) and that nothing protrudes
into the path of light (e.g. temperature probes, stirrer and tubing when using the Dual Syringe Automated
Titrator).

A spacer can be installed at the bottom of the holder to reduce the vertical distance between cuvette
base and window base and thus reduce the sample volume required.

Some cuvettes have a thicker base. For these types of cuvettes, make sure to
remove the spacer, as otherwise the quartz glass base protrudes into the path
of light.

Depending on the target measurement temperature, the Single Cell Peltier
Holder, cuvette holder and cuvette may be very hot or cold, causing injury to
the user when touched. Ensure that they have been allowed to reach a safe
temperature before handling or use protective equipment (e.g., thermally
protective gloves) if their insertion or removal at extremely high or low
temperature is required. Always use the provided plastic lid for the cuvette
holder  to avoid accidental contact with its top surface if hot. Carry out risk
assessment and consider additional personal protective equipment if in doubt.
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Depending on system configuration and experiment design, target

measurement temperature can reach between -20°C and 150°C. Extra care

should be taken when handling a potentially hot/cold cuvette as the target

measurement temperature is actively set through computer control and
monitored only via the Peltier controller display or the control software. As
unsafe temperatures cannot be identified otherwise (e.g., after hard- and
software is switched off or fails), the Chirascan V100 may only be used by, or
under supervision of, trained laboratory personnel familiar with this user
manual and the risks associated with usage of the system and related
procedures, particularly when conducting experiments at elevated sample
temperatures.

Quartz glass cuvettes are typically used with the instrument and should be
handled with care. Make sure not to use damaged or chipped cuvettes and
follow local guidelines for safe handling of laboratory glassware.

At elevated target temperatures the cuvette holder may become very hot. To avoid accidental contact
with its top surface, place the provided plastic lid shown in Figure 18 on the holder. Its hole still allows
usage of in-sample temperature probes .

Figure 18: Plastic lid for the cuvette holder

7.7.3 Compatibility with Accessories

The Stopped-Flow accessory replaces the entire sample chamber if installed. 

Any of the following accessories are available for the Chirascan V100 and replace the Single Cell Peltier
Holder in the sample chamber if installed:

· 6-Cell Peltier Holder
· High Shear Couette Cell Linear Dichroism (LD) accessory
· Solid Sample Holder
· Integrating Sphere
· Magnetic Circular Dichroism (MCD) accessory

The following accessories are used together with the Single Cell Peltier Holder:

· CCD Emission Fluorometer
· Total Fluorescence accessory
· Scanning Emission Monochromator (SEM)
· Dual Syringe Automated Titrator
· pH Probe
· Optical Rotary Dispersion (ORD) accessory
· Near-Infrared (NIR) extension
· Fluorescence Polarization (FP) accessory

55



53

Chirascan V100 User Manual 
 
                                                                                                                    © 2023 Applied Photophysics Limited

Hardware

· Circularly Polarized Luminescence (CPL) accessory

The CCD Emission Fluorometer, Total Fluorescence accessory, Scanning Emission Monochromator ,
and Fluorescence Polarization accessory can also be used together with the 6-Cell Peltier Holder.

For more information on accessory compatibility, please contact  Applied Photophysics Customer
Support.

7.8 Temperature Control

Depending on the target measurement temperature, the Single Cell Peltier
Holder, cuvette holder and cuvette may be very hot or cold, causing injury to
the user when touched. Ensure that they have been allowed to reach a safe
temperature before handling or use protective equipment (e.g., thermally
protective gloves) if their insertion or removal at extremely high or low
temperature is required. Always use the provided plastic lid for the cuvette
holder  to avoid accidental contact with its top surface if hot. Carry out risk
assessment and consider additional personal protective equipment if in doubt.

Depending on system configuration and experiment design, target

measurement temperature can reach between -20°C and 150°C. Extra care

should be taken when handling a potentially hot/cold cuvette as the target

measurement temperature is actively set through computer control and
monitored only via the Peltier controller display or the control software. As
unsafe temperatures cannot be identified otherwise (e.g., after hard- and
software is switched off or fails), the Chirascan V100 may only be used by, or
under supervision of, trained laboratory personnel familiar with this user
manual and the risks associated with usage of the system and related
procedures, particularly when conducting experiments at elevated sample
temperatures.

The Peltier effect is used to raise or lower the temperature of the sample holder: when a current is made
to flow across the junction of two dissimilar electrical conductors, the result is an increase in
temperature on one side of the junction, and a decrease in temperature on the other. If the current is
reversed, the direction of the thermal gradient will also be reversed. Unlike resistive heating, the Peltier
effect can therefore be used for both heating and cooling. 

To maintain the temperature gradient, the current must also be maintained, meaning that electrical
energy must be continuously supplied to the system, resulting in the generation of heat which must be
removed. Circulating water  is used for this, but it is important to remember that the circulating water
is not controlling the temperature of the system, it is only removing excess heat, and the temperature of
the circulating water does not need to be controlled accurately.

For measurements at elevated temperatures, subject any aqueous buffer or
samples to removal of excess dissolved gas (e.g., using a vacuum pump
connected to a desiccator) to prevent bubble formation in the cuvette (and to
remove oxygen), particularly when performing temperature ramps. If using an
in-sample temperature probe, seal the cuvette opening where the probe sits
with Parafilm to prevent sample evaporation. In absence of an in-sample
temperature probe, close cuvettes with stoppers.
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7.8.1 Sample Temperature Control

The sample temperature is read by a in-sample temperature probe positioned in the wall of the Single
Cell Peltier Holder, and the temperature is controlled to this temperature probe readout by a Peltier
device embedded in the Single Cell Peltier Holder in close thermal contact with the sample cuvette.

The Peltier device of the sample chamber is controlled by the Peltier control module shown in Figure 19
(left). The rear of the Single Cell Peltier Holder control module is shown in Figure 19 (right). The mains
connection port connects to the mains electricity supply using the mains cable provided. The USB-B
port connects to a USB port on the computer. The sample holder port connects to the 25-pin D-sub port
on the rear of the sample chamber (Figure 17). The remaining ports are not used for the Single Cell
Peltier Holder. 

The Single Cell Peltier Holder and control module are calibrated as a pair; the
holder should only be used with the control module indicated by the serial
number on the rear.

The front panel of the control module displays the current and target temperature of the Single Cell
Peltier Holder (which is the same as displayed in the The Temperature Control Unit panel ), but is not
used to adjust any temperature settings. The front panel is only used to control the magnetic stirrer
integrated in the Single Cell Peltier Holder.

To switch on or off the stirrer, first press the right arrow button two times to go to the Set stirring menu
and then press the Set button. Alternatively, switch the stirrer on or off in the Stirrer control dialog  in
Chirascan Control . To set the stirrer speed, select the Set stirring menu, then use the up and down
arrow buttons to change the stirrer speed and press the Set button to confirm. For more information
about how to use the front panel of the Peltier controller, please refer to the manual for the controller by
Quantum Northwest.

The Chirascan V100 is powered by the mains electricity supply which can
produce an electric shock leading to serious injury or death. Do not connect or
disconnect electrical leads to the mains supply unless the supply is powered
off at source. Exercise care during operation and do not operate units with
their covers removed. In the case of emergency, switch off the system at
mains power outlet / switchboard. For reconfiguration or maintenance, switch
off the system power supply unit before disconnecting any cables.

Ensure all communications and electrical connections are made and any
jackscrews (if present) are tightened before powering on the spectrometer.
Operate the spectrometer using only the cables provided. Never operate a
spectrometer or any peripherals such as the Peltier controller with damaged
cables.

The Chirascan V100 must not be used if any displays, indicators (e.g., for
lamp status and sample temperature) or warning devices (e.g., nitrogen alarm
system) are not operable.

Power on the Peltier Control module at the ON/OFF switch on the rear of the module (Figure 19) before
starting Chirascan Control. The target temperature is set in the Chirascan software on the Temperature
Control Unit panel . Communication between control module and software can be reestablished  in
the Chirascan software if the control module has been switched on after starting the software or when
the Single Cell Peltier Holder has been reinstalled after using the 6-Cell Peltier Holder.
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Figure 19: The Peltier temperature control unit for the sample chamber front view (left) and rear view with
connections (right)

Do not power on the Peltier control module unless the Peltier devices have a
throughput of water, as this may cause the Peltier elements to reach
excessive temperatures and get damaged.

Note that the sample temperature may differ slightly from the target temperature, particularly at very high
or low temperatures. Therefore, it is recommended to monitor the sample temperature with the in-sample
temperature probe  whenever possible. The Peltier device requires a throughput of water to act as a
heat sink, which is provided by a water circulator .

7.8.2 The In-Sample Temperature Probe

The sample chamber can accept up to four in-sample temperature probes that are immersed in the
sample during acquisition and thus give an accurate reading of the sample temperature. The temperature
probes connect to the block to the right rear of the sample chamber  (Figure 15). The electronics box
of a temperature probe can be mounted to the right inner wall of the sample chamber using velcro.

Note that the lowest connector on the block, marked Stir, is no longer used, the next, marked Lid, is
used for the lid open sensor, and the upper four, marked T1 to T4 from the lowest up, are used for
temperature probes. Normally, if a single temperature probe is used, it connects to T1.

A temperature probe can be connected to any of the available connectors and
multiple temperature rpobes can be installed at the same time. To enable
monitoring of sample temperature as measured by the desired temperature
probe, the corresponding entry must be selected in Chirascan Control  . If
the correct temperature probe is not selected, a wrong temperature might be
recorded or none at all.

Two temperature probes are supplied as standard with the Single Cell Peltier Holder (Figure 20). One of
these is normally connected to T1. The two standard temperature probes have nominal diameters of 0.8
and 0.25 mm, and are typically used together with the standard 10-mm and 0.5-mm cuvettes,
respectively. The in-sample temperature probes are not suitable for use with cuvettes with a path length
of less than the temperature probe diameter.

When using a temperature probe, make sure that the probe tip does not protrude into the path of light.

In-sample temperature probes are only used for recording the sample
temperature; the target temperature is still controlled to the Single Cell Peltier
Holder thermocouple. This should be considered when planing temperature
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ramp experiments  as the temperature recorded by an in-sample
temperature probe typically lags behind that recorded by the holder
thermocouple.

Figure 20: In-sample temperature probes for short (left) and long (right) path length cuvettes

7.8.3 Peltier Heat Dissipation

Circulating water flows through a heat exchanger which removes heat from the Peltier device. Insufficient
flow will allow the temperature of the heat exchanger to rise, and if a certain cut-off value is exceeded,
the Peltier control module will automatically stop controlling the Peltier element. 

The water circulator must be sitting on a plane and sturdy surface, ideally on
the floor beneath the system. Make sure that tubing is routed unobstructed
and retained to prevent trip and pull hazard. Make sure tubing is regularly
inspected for leaks to prevent spills that might result in slip and trip hazard.

The standard water circulator provided with the Chirascan V100 has fan-assisted cooling but no other
temperature control and is shown in Figure 21. Switching on the water circulator is accompanied by an
alarm sound that becomes also active if the water tubing is blocked or the liquid level is too low. Always
switch off Peltier controller and water circulator when temperature control is not required.
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Figure 21: The water circulator (left) and circulator quick release fittings (right)

If a water circulator other than the standard one is used, it must fulfill certain requirements. The Single
Cell Peltier Holder requires a circulating water flow rate of about 200–300 ml per minute. To achieve this,
a pressure of approximately 0.2 to 0.3 bar (3 to 4 psi) is needed.

If the water pressure of the water circulator is too high, the tubing can be
forced from the connectors within the spectrometer sample chamber. Do not
exceed an input water pressure of 1.7 bar (24 p.s.i.).

If a temperature-controlled unit is used, the temperature should be set to about 5°C below the target
temperature. Cooler circulating water can improve the performance of the Peltier element at low
temperatures, whereas warmer water can improve performance at very high temperatures.

The circulator is connected to the tubing at the outer rear of the sample chamber  through quick
release Legris type fittings (Figure 21). Inlet and outlet of the water circulator can be connected either
way.

It is recommended to supplement the circulating water with additives such as 10% ethylene glycol to
prevent microbial growth.

To prevent the buildup of deposits such as limescale, distilled water should be
used as the circulating fluid. To prevent corrosion, a small amount (~1%) of
tap water should be added. Moreover, the addition of an anti-bacterial agent
and antifreeze is recommended, provided that these comply with the circulator
supplier’s specifications. When supplementing the circulating water with
additives, make sure to follow the chemical manufacturer's guidance on dosing
and precautions.

7.9 Reconfiguration

Upon reconfiguration of the system, ensure that any parts are being installed
as described, screws tightened, electrical connections fixed with jackscrews
(if applicable), and gas fittings secured.
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7.9.1 Removing the Sample Chamber

The light source of the Chirascan V100 is a 150-watt xenon or mercury-xenon
arc lamp that produces intense UV radiation that can be harmful to skin and
eyes and may even impair eyesight permanently. Do not allow the skin to be
exposed to UV radiation. Never look directly at the light source. Do not power
on the lamp unless it is correctly mounted in the lamp housing. Do not remove
the lamp system cover and do not open the lamp housing while the lamp is
operative, as indicated by the yellow lamp system cover indicator. Do not
attempt to remove the UV filter of the lamp housing port. Do not attempt to
remove the Single Cell Peltier Holder or any accessory that replaces it unless
the lamp is powered off or the lamp shutter is closed.

Never operate the lamp of the spectrometer if the sample chamber is detached
- otherwise risk of direct exposure to UV light is imminent! Detachment of the
sample chamber is only required for replacement against the Stopped-Flow
accessory or vice versa. Never remove the sample chamber except for this
purpose. If reconfiguring for the accessory, the lamp must be switched off
beforehand and guidance in the accessory user manual must be followed.

Removing or reinstalling the sample chamber is necessary when using the Chirascan Stopped-Flow
accessory .

The sample chamber attaches to the monochromator section of the spectrometer with three
thumbscrews and one socket head screw at the upper front (Figure 22). To remove the sample chamber,
disconnect the nitrogen purge gas connection (Figure 14), release the thumbscrews, remove the socket
head screw using a 6 mm hexagon key, and slide the sample chamber to the right, away from the
monochromator.

Never alter height of the monochromator leveling feet, as this may impair light
path alignment. Height adjustment of the three adjustable feet beneath the
sample chamber should not be necessary under normal operation of the
system, including usage of the Chirascan Stopped-Flow accessory. Upon
sample chamber re-installation, the sample chamber and monochromator
should align precisely after tightening the sample chamber thumb screws.
Only adjust height of the sample chamber feet if the latter happens not to be
the case. This can be done by turning the bolts of the feet with a 13 mm
spanner (clockwise to decrease height / anti-clockwise to increase height).
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Figure 22: The interior of the sample chamber, viewed from the right

A location guide and an O-ring (Figure 23) are located between the sample chamber and the
monochromator—make sure to store these parts and have them available for re-installation of the sample
chamber.

 
Figure 23: The O-ring (left) and locator guide (right)

To replace the sample chamber, perform the removal operation in reverse; before attaching the sample
chamber to the monochromator, insert the O-ring into the recess of the monochromator, and insert the
location guide into the port on the outside of the sample chamber, with the narrow rim facing the sample
chamber (Figure 24). Then attach the sample chamber, ensuring that it sits flush against the
monochromator and that all thumb screws are in place and tightened securely.
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Figure 24: The monochromator on the left side and the sample chamber monochromator port on the
right side without (left) and with O-ring and locator guide in place (right)

7.9.2 Removing the Single Cell Peltier Holder

Removing the Single Cell Peltier Holder is necessary when using some of the accessories  available
for the Chirascan V100.

The Chirascan V100 is powered by the mains electricity supply which can
produce an electric shock leading to serious injury or death. Do not connect or
disconnect electrical leads to the mains supply unless the supply is powered
off at source. Exercise care during operation and do not operate units with
their covers removed. In the case of emergency, switch off the system at
mains power outlet / switchboard. For reconfiguration or maintenance, switch
off the system power supply unit before disconnecting any cables.

Ensure all communications and electrical connections are made and any
jackscrews (if present) are tightened before powering on the spectrometer.
Operate the spectrometer using only the cables provided. Never operate a
spectrometer or any peripherals such as the Peltier controller with damaged
cables.

To the left and right of the Single Cell Peltier Holder, a threaded spacer and a detector cowling enclose
the path of light and minimize the sample chamber volume that must be purged  with nitrogen. For
removal of the Single Cell Peltier Holder, start with removing these two parts shown in Figure 25.
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Figure 25: The threaded spacer (left) and detector cowling (right)

First, release the detector as described in Detector Installation and Replacement . The detector snout
sits in the cowling, which rests against the right face of the Single Cell Peltier Holder. The cowling has a
purge gas inlet, which connects to the ‘T’ connector at the upper rear of the sample chamber. Detach
the purge gas tubing from the inlet, then slide the detector out of the cowling and remove the latter.

To the left of the Single Cell Peltier Holder, the extendable threaded spacer fits between the
monochromator light inlet aperture and the Single Cell Peltier Holder. The spacer has O-rings at each
end: the narrower end faces towards the SingleSingle Cell Peltier Holder, while the wider, threaded end
faces towards the monochromator. To remove the threaded spacer, turn its two parts against each other
clockwise until the spacer is short enough for removal.

The interior of the sample chamber should now appear as in Figure 26.

Figure 26: The interior of the sample chamber with the threaded spacer and detector cowling removed

Ensure that the threaded spacer connecting monochromator with Single Cell
Peltier Holder and the detector cowling connecting Single Cell Peltier Holder
with detector are in place before igniting the lamp, as otherwise there is risk of
exposure to UV light.

Next, remove the purge gas tubing by disconnecting it both at the base of the Single Cell Peltier Holder
and at the ‘T’ connector at the upper rear of the sample chamber. Purge gas connections are secured by
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push fit connectors, which are released by pressing the outer (orange) flange towards the connector
body. 

Disconnect the Legris type fluid circulator connectors: release the connectors by pushing down the
metal latches, then pull out the connector terminals.

Now disconnect the Single Cell Peltier Holder communications cable: release the wire clips that secure
it, then pull out the connector from its plug.

Finally, detach the Single Cell Peltier Holder from the sample chamber support plate. Do so by releasing
the two captive thumbscrews positioned at the right front and left rear of the Single Cell Peltier Holder
mounting plate. Lift out the SingleSingle Cell Peltier Holder while making sure that the fluid circulator
tubing and communications cable are kept clear.

To re-install the Single Cell Peltier Holder, perform the removal operation in reverse. 

7.9.3 Detector Installation and Replacement

It is necessary to reconfigure the detector setup in the sample chamber in certain instances, e.g.

· to replace the CD detector by a different one when using the Chirascan Near IR Extension accessory 
· to relocate the CD detector to the fluorescence detector port  (e.g for Fluorescence-Detected CD

(FDCD) measurements)
· to install a fluorescence accessory  such as the CCD Emission Fluorometer (Figure 27)

Even if the detector setup remains unchanged, releasing the CD detector is necessary to make room for
removing  the Single Cell Peltier Holder in preparation for installing Chirascan accessories  that
replace the Single Cell Peltier Holder, or to replace a faulty detector.

The large area avalanche photodiode (LAAPD) detector supplied with the
Chirascan V100 operates at high voltages and can produce an electric shock
leading to serious injury or death. Do not connect or disconnect the detector
from the spectrometer unless the spectrometer is powered off or detector high
voltage is set to zero via the Zero HV button in the shutter / attenuator panel
of the Chirascan Control SCP.

Never operate the lamp of the Chirascan V100 with an open CD detector port.
If the detector must be removed, e.g., for replacement, shut off the lamp
beforehand. If the CD detector is not required during system operation, e.g., if
exclusively fluorescence measurements are carried out, the CD detector port
must be blanked off using the blanking plate provided.

Before releasing or replacing a detector, ensure that the spectrometer is powered off  or detector high
voltage is set to zero via the Zero HV button in the shutter / attenuator panel  of the Chirascan Control
SCP.

The detectors are held in place by knurled locking rings, and are released by turning the ring
anticlockwise (counterclockwise); the detectors can then be slid gently from their ports. For detector
removal, disconnect the detector cable.

To install a detector, slide it into the detector port so that it seats down into the detector cowling, then
tighten the knurled locking ring by rotating it clockwise to secure the detector in position. 
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After detector installation, the interior of the sample chamber appears from the front as in Figure 27 (note
that the CCD Emission Fluorometer is not fitted to every spectrometer). If a detector port is not in use, it
is sealed with a blanking plate (Figure 16).

Figure 27: The interior of the sample chamber in front view with CD detector installed and CCD Emission
Fluorometer in the fluorescence detector port

To protect a detector when it is not installed on the spectrometer, fit it with the window cover.

Figure 28: Detector fitted with window cover

For instructions on the installation of the optional CCD Emission Fluorometer  or other optional
fluorescence accessories, see the corresponding accessory user manual.
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8 Software

This Chapter describes the Chirascan V100 software, covering the different programs  used to operate
the system.

Prolonged operation of computers and display screen equipment may cause
discomfort or even harm the user. It is the user's responsibility to carry out a
risk assessment of the system's workstation, if required, and enforce further
administrative and/or procedural measures to prevent related risks and comply
with local workplace health and safety regulations

8.1 The Active Nitrogen Management System

The Active Nitrogen Management System (ANMS) software is the interface of the ANMS  which
controls nitrogen purging of the system. After starting the software, choose the right COM port in the
drop-down menu at the upper left and click Connect to establish communications between the ANMS
software and the ANMS electronics. After initialization, the lamp and nitrogen flow rate status can be
viewed on the Monitor tab. Timings for a lamp ignition schedule can be set by the user on the
Schedule tab. All other tabs can be viewed, but are password protected, and it is recommended that
the defaults set by Applied Photophysics are not changed. For information on how to change these
settings, please contact  Applied Photophysics Customer Support.

8.1.1 Manual Display and Control

The current nitrogen flow rates are shown on the center panel on the Monitor tab (Figure 29). From left
to right the indicators show the flow rates to the lamp, monochromator and sample chamber,
respectively, in liters per minute. The flow rates are also shown numerically in the top panel to the left.
The default flow rates of 1 L/min, 3 L/min, and 1 L/min for the lamp, monochromator, and sample
chamber, respectively, are usually adequate.

Figure 29: The Monitor tab of ANMS
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To start the timed lamp ignition sequence, make sure that the lamp power switch on the front panel
is switched on and click Start Lamp Ignite Sequence. The other buttons on the two panels to the right
of this tab can be used to turn on or off the nitrogen and/or lamp without running the sequence (the
nitrogen cannot be turned off without turning the lamp off, too). The lamp status is shown in a box below
the buttons, which is green if the lamp is lit correctly and red if the lamp has not been lit correctly,
although it has been scheduled to be turned on. Green text on the buttons indicates that a connection to
the ANMS electronics has not yet been established.

8.1.2 Scheduling Purging

Timings for the nitrogen and lamp are set on the Schedule tab (Figure 30). A Startup and a Shutdown
schedule are allowed; remember to check that the scheduled Shutdown time is after the completion of
any experiments that you are running. 

To set a schedule, click Set Schedule Time, tick the check boxes for the required days (the M-F
check box activates the schedule for all work days) and set the times for the nitrogen purge to begin in
the Hours Minutes Seconds boxes which operate on a 24-hour clock. Tick the Run Once check box if
you want the schedule to be initiated once only.

Figure 30: The Schedule tab of ANMS
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8.2 Chirascan Control

This section describes the Chirascan Control program, the purpose of which is to control the
spectrometer and its accessories and to acquire data

8.2.1 Introduction

8.2.1.1 Launching Chirascan Control

If PC and spectrometer have been connected by USB, two-way communications between Chirascan
Control and the spectrometer will be established when Chirascan Control is launched. If there is no
connection between the PC and the spectrometer, Chirascan Control can be opened in Emulation Mode.
Emulation Mode can be used for testing purposes and does not require the spectrometer to be powered
on. A label in the title bar indicates that the software has been launched in emulator mode (Figure 31).

Figure 31: Indication for Emulator Mode

Simulated data (including spectral properties, temperatures etc.) can be obtained by performing an
acquisition in Emulation Mode. An entry in the Remarks  of a Datastore will indicate that it was
obtained in Emulation Mode.

8.2.1.2 The Spectrometer Control Panel

Chirascan Control is versatile enough to cope with a wide variety of experiments while being simple to
use. It operates under Windows 10 and some earlier versions of Windows.

The software is launched by clicking on its desktop icon. The Chirascan Control spectrometer control
panel (SCP) shown in Figure 32 will appear. The layout of the SCP follows Microsoft Windows
conventions.
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Figure 32: The Spectrometer Control Panel

There are two main areas on the SCP:

· The menu bar and toolbar
· A number of panels on which information is entered and viewed



69

Chirascan V100 User Manual 
 
                                                                                                                    © 2023 Applied Photophysics Limited

Software

The toolbar can be displayed or hidden by using the View menu .

8.2.2 Configuring Signal and Attenuator Settings

8.2.2.1 The Signal Panel and Live Display

The Signal panel (Figure 33) is used to select the mode of data collection. Unless other accessories
are fitted, three options can be selected from the drop-down menu by default: Circular Dichroism,
Absorbance and Voltage. CCD, Fluorescence or other items can be selected if those accessories are
fitted. Please refer to the corresponding accessories user manuals for more information about these
modes of data collection. The panel changes appearance to reflect the mode of data collection.

Figure 33: The Signal panel

Common to all modes is an oscilloscope-style live signal display (Figure 34) that can be launched by
clicking the corresponding icon in the top right corner of the panel (Figure 33). The units will be those of
the chosen measurement mode; an instantaneous value of the measurement is also displayed in the
box to the right of the drop-down menu.
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Figure 34: The Live Signal display

8.2.2.2 The Signal Panel for Circular Dichroism Measurements

The most commonly used mode of data collection is circular dichroism. When this option is selected,
the Signal panel has two sub-panels, Options and Background (Figure 33). On the Options
sub-panel, choose either delta A (delta absorbance) or millidegrees for the units of the CD
measurement. 

If the AutoPM check box is ticked, the LAAPD detector gain will be adjusted so that the detector output
is at optimum level for the electronics. This adjustment requires a short assessment of the current light
throughput preceding actual acquisition and can increase total scan time for a given data point by up to
25%. As the duration of this initial assessment depends on light throughput and light throughput
typically decreases towards shorter wavelengths, the AutoPM function typically increases scan duration
towards lower wavelengths in particular. The dependence of scan duration on light throughput also is the
main reason why the duration of an acquisition cannot be exactly predicted and the Sampling panel
provides an approximate scan time only. However, AutoPM usually increases scan time only marginally
and is recommended to be used at all times.

Tick the Absorbance check box if you wish to simultaneously record an absorbance spectrum of the
sample (recommended) but note that a background must be acquired before the absorbance can be
obtained. To acquire a background spectrum, click Background on the Signal panel (Figure 34). The
background spectrum must have a point corresponding to each point in the measured spectrum (it may
have additional points). It is not necessary to take a background spectrum if only the CD measurement
is required.

In CD mode, the absorbance is derived from the detector gain, which is know precisely, and the
absorbance is therefore identical to that measured in direct absorbance mode.

The Fluorescence check box will be disabled unless the spectrometer is equipped with the Total
Fluorescence or Scanning Emission Monochromator accessory. See the user manual for these
accessories for further information.
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Likewise, if the CCD Emission Fluorometer is installed, a CCD check box is present in the Options
sub-panel that allows you to record fluorescence excitation and/or emission spectra if ticked. For more
information on making fluorescence measurements with the CCD Emission Fluorometer, see the CCD
Emission Fluorometer user manual.

The Background sub-panel of the Chirascan Control SCP is used to acquire a background. Clicking on
Background will initiate a background acquisition using the current settings. Chirascan Viewer will be
launched automatically and a display window will show the CD background trace. The acquisition can be
stopped at any time by clicking Stop, which is the label that appears on Background during an
acquisition; it can also be Paused and Resumed, using the buttons in the Sequencer panel . At the
end of the acquisition, the background will be stored in the current Working Directory  as a .dsx file,
the name of which is generated by a seed name (the default seed name for background data is ‘Base’)
and a running number with leading zeros (e.g., ‘Base0001.dsx’), unless a different seed name has been
specified (Configuration → Preferences → File names, or File Names toolbar  icon). If the file
name already exists, a Save As dialog will open showing the current working directory and the data can
be saved with a different name or in a different location. The Auto Subtraction check box becomes
enabled at the conclusion of a background scan; tick the box if you wish to subtract the background
automatically from subsequently measured spectra.

Figure 35: The Quickview - CD Background(s) dialog

The Show… button is used to reinstate a previously-measured background. It calls up the Quickview -
CD Background(s) dialog that enables you to load any background file (Figure 35).

Click on Recall Last to reinstate the most recently measured background; click on Load… to browse
for other background files. The chosen file will appear in the preview window. Clicking Smooth will
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smooth the trace, which is useful if you wish to subtract a single background from an average of a
number of spectra. Under these circumstances, smoothing prevents reinforcement of the background
noise in the final result. However, it is recommended to subtract single backgrounds from single spectra.

The Save… and Print… buttons have their usual functions. Click OK to confirm your choice and close
the dialog or Cancel to close without implementing the new background.

Calibration is used to recalibrate the CD scaling factor and requires administrator privileges to gain
access to it. It should not be necessary to use it routinely and will be disabled for the normal user.
Please contact  Applied Photophysics Customer Support if you wish to recalibrate the CD scaling
factor.

8.2.2.3 The Signal Panel for Direct Absorbance Measurements

When Absorbance is selected on the Signal panel (Figure 36), the absorbance will be measured
directly, rather than derived from the detector gain as is the case when the Absorbance check box is
ticked with Circular Dichroism selected. Accurate values comparable to those obtained on a dedicated
absorbance spectrometer are obtained in both cases, but when Absorbance is selected the CD signal
cannot be measured simultaneously.

Figure 36: The Signal panel with Absorbance selected

The Options sub-panel enables you to choose between Absorbance and Transmission as the
measured variable. If the Total Fluorescence or Scanning Emission Monochromator accessory is
present, a simultaneous fluorescence excitation spectrum can be measured by ticking the
Fluorescence check box. For more information on making fluorescence measurements, see the user
manual of the corresponding fluorescence accessory.

The Baseline sub-panel is used to measure a reference background relative to which the absorbance of
the sample is calculated. Ticking the Auto HV check box will optimize the gain applied to the detector
for every point in the background scan, similarly to the AutoPM  function in CD signal mode. In
absorbance mode however, these background values are remembered and applied at each
corresponding point in subsequent absorbance scans, allowing an accurate absorbance spectrum to be
recorded easily. Usage of the Baseline sub-panel is similar to that for CD measurements.
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8.2.2.4 The Signal Panel for Voltage

This panel is intended for diagnostic purposes only and, thus, not required in the course of normal
instrument use.

8.2.2.5 The Shutter / Attenuator Panel

The light source of the Chirascan V100 is a 150-watt xenon or mercury-xenon
arc lamp that produces intense UV radiation that can be harmful to skin and
eyes and may even impair eyesight permanently. Never have the lamp
powered on, the shutter of the spectrometer monochromator opened manually
(i.e., by clicking Open in the Shutter / Attenuator panel), and the sample
chamber lid opened simultaneously.

This part of the SCP controls the shutter/attenuator mechanism, which is essentially an aperture that
regulates the light intensity the sample is exposed to. The shutter/attenuator can be opened or closed
by clicking Open and Close, respectively. The black rectangle to the right of these buttons represents
the aperture, and the yellow circle represents its opening: the smaller the attenuator opening is the more
the black rectangle occludes the circle (Figure 37).

Figure 37: The Shutter / Attenuator panel

Click Zero HV to set the voltage on the detector to zero, for example, if you want to exchange the
detector. With zero voltage on the detector, the button will read Restore HV. Click to restore the voltage
to its previous value. 

The AutoShutter check box is ticked by default. This provides automatic opening of the shutter at the
start of a scan and closes it at the end. It also closes the shutter while waiting for the temperature to
stabilize during temperature-ramp experiments or during titration experiments when waiting for titrant to
be added. The main purpose of Autoshutter is to minimize the exposure time of a sample and of the
optical components of the monochromator to intense radiation.

8.2.3 Configuring Acquisition Settings

A set of acquisition settings is designed to provide instructions to the spectrometer to carry out a
measurement or a series of measurements according to your requirements. A set of acquisition settings
can be saved through the File menu  as as new file and recalled later either through the File menu
or by dragging the file from the Launchpad file list  onto the SCP .

8.2.3.1 The Monochromator Panel

The Monochromator panel (Figure 38) provides access to the settings that control the operation of the
Chirascan V100 monochromator. Here you set the wavelength range, step size and bandwidth for your
experiment; you can also move the monochromator to a specific wavelength.
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Figure 38: The Monochromator panel

To drive the monochromator to a specific wavelength, use the Wavelength (nm) input box and click Set
below the box; to set the bandwidth, use the Bandwidth (nm) input box and click the same Set button.
Setting wavelength and bandwidth can be done simultaneously with a single click.

To set the wavelength range for a scan, use the Low and High input boxes to set the lower and upper
wavelength limits; use the Step input box to set the step size; all units are nanometers. Click Set to the
right of these boxes to confirm these settings. Note that the spectrometer always scans from high to low
wavelength. If discrete wavelengths or a skip-scan have been defined in the advanced monochromator
setup , the Step box will be disabled and display “---“.

8.2.3.2 Advanced Monochromator Setup

The Monochromator Scan Setup - Advanced dialog (Figure 38) is opened by clicking Adv... in the
Monochromator panel  and can be used to set the software up to perform discrete wavelength scans
or skip-scans.
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Figure 39: The Monochromator Scan Setup - Advanced dialog

Discrete wavelength scans

Discrete wavelength scans are useful when following a change in property as a function of some
independent variable other than wavelength - temperature, for example.

To do so, select Single wavelength, specify the wavelength in the associated input box and click OK. 

It is possible to create a list of more than one discrete wavelengths. Clear the wavelength list by clicking
Clear list and then tick Append to list. Now select Single wavelength, specify the wavelength in the
input box and click on Generate list. Each time you type in a wavelength and click on Generate list,
the specified single wavelength will be appended to the list. When you are satisfied with the list of
wavelengths, click OK.
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Skip-scans

A simple wavelength range can be set in the Monochromator panel and there is no need to use the
advanced panel to set such a range. However, if you wish to carry out a more sophisticated scan, select
Wavelength range in the Monochromator Scan Setup - Advanced dialog. Clear the wavelength list
by clicking on Clear List and tick Append to list. Now specify the Start, Stop and Step values for the
first wavelength range and click on Generate list. A number of entries that correspond to your
specification will appear in the list. Repeat this procedure to append additional wavelength ranges until
you have completed the skip-scan list. In general, skip-scans are used to reduce acquisition time by
excluding wavelength ranges that are known to be unimportant for well-described samples.

Ticking the No fly-back check box will let the monochromator remain at the lowest wavelength of the
given wavelength range once reached instead of moving back to the first one. Ticking No Scan will
prevent the scan from commencing at all. Both functions are for the use of Applied Photophysics
engineers and should not be ticked for normal user operation.

Use the Save As… button to save the list as a .conf (configuration) file that can be retrieved using the
Load button in the future. This obviates the need to generate the same list every time it is required.

Addition of single wavelengths and wavelength ranges can be combined to create a list. The total number
of entries in the list is displayed below the list. With the list generated, click on OK to return to the SCP.
At the onset of a measurement, the monochromator will drive to the specified wavelengths in the order in
which they appear in the list and the chosen property (CD, absorbance, voltage, etc., depending on
measurement mode) will be recorded.

8.2.3.3 The Trigger and Timebase Panels

The Trigger and Timebase panels (Figure 40) are visible when operating in Kinetics mode  or
Spectra-Kinetics mode . The Trigger drop down menu will allow the selection of Internal only unless
the Chirascan Stopped-Flow accessory is fitted. 

Figure 40: The Trigger and Timebase panels

The acquisition Time and number of data Points are set using the drop-down menus in the Timebase
panel. The Samples box displays the number of samples which will be averaged in order to obtain each
data point. Ticking the Logarithmic check box results in a logarithmic distribution of data points over
the selected acquisition time. This feature may be useful when the kinetic change being monitored has a
fast initial phase, but a slower second phase. As an alternative, a Split Timebase may be used in
which data points are distributed between two linear intervals.

8.2.3.4 The Sampling Panel

The Sampling panel (Figure 41) is visible when operating in Spectrum mode , and is used to control
the sampling time for each point in a scan. Use the Time-per-point (s) edit box to specify the time in
seconds to be spent collecting data at each point; an Approximate scan-time is calculated based on
the product of the time-per-point and the number of points in the scan (which is equal to wavelength
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range divided by the step size as specified in the Monochromator panel ). Note that this is an
approximate scan time, because the LAAPD detector gain is tuned to optimize the CD signal
(AutoPM  function), which is a feedback process of variable duration, and monochromator movement
adds to the total scan time as well.

Figure 41: The Sampling panel

If the Enable Adaptive Sampling check box is ticked, the time-per-point is varied inversely as a
function of the light reaching the detector. Where the signal is weaker, more time is spent collecting
data than where it is stronger. The algorithm has been developed such that it will usually take less time
to measure a spectrum than at constant time-per-point.

Advanced sampling settings can be configured in the Sampling-Advanced dialog  which is opened by
clicking Adv....

8.2.3.5 The Sampling-Advanced Dialog

Advanced sampling settings can be configured on the Sampling – Advanced dialog (Figure 42), which
is opened by clicking Adv… on the Sampling panel . 

The Sample Period is the interval between successive data acquisitions, i.e. samples, on the
electronics (or the reciprocal of the data acquisition frequency). By default, this is set to 25.0 μs, which
is close to the lower limit achievable by the electronics. It is recommended that this value is not
changed.

The Default number of samples is the time-per-point  divided by the sample period as given by
Equation 3:

Number of samples = time-per-point / sample period (3)

If the default number of samples or sample period is changed on this dialog, the time-per-point  on the
Sampling  panel changes accordingly. For example, for the default sample period of 25.0 µs and a
number of 40,000 samples performed by the spectrometer electronics, the time-per-point is 1 second.
Conversely, if the time-per-point is adjusted, the number of samples changes accordingly. 

Typically, a number of samples are accumulated and averaged (oversampled) for each point of a
wavelength scan or kinetic measurement reported by Chirascan Viewer in order to improve the signal-to-
noise of the collected data. Most electronic scientific instruments operate in a similar way but usually
report only the average of the samplings. However, the Chirascan V100 also reports a standard error,
which is calculated based on the samplings as follows: First, all samplings are divided into bins with a
size of 100 samplings each, and for each bin the mean of samplings is calculated. Then the standard
error of these means, σ

M
, is calculated according to Equation 4.

σ
M
 = σ / √N (4)
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where σ is the standard deviation of the sampling means and N is the number of bins, i.e. 400 bins for a
default number of 40,000 samplings. σ

M
 is a measure of how close the measured mean is to the actual

mean, i.e. there is a ~95% chance that the true mean lies within 2 σ
M
 of the measured mean.

Figure 42: The Sampling - Advanced dialog

Calculation of the standard error upon acquisition can be disabled by ticking the Disable Standard
Error check box (the other functions on this dialog should only be changed under instruction from
Applied Photophysics). By default, display of the standard error  in Chirascan Viewer error is enabled.

If Disable oversampling is ticked, a single sample will be collected from the electronics for each point
of the scan, rather than averaging multiple acquisitions (oversampling). This will generally lead to
extremely noisy data and is not recommended.

The settings in the Adaptive sampling limits panel limit the number of samples when adaptive
sampling  is enabled (i.e. constant S/N mode) in the main SCP and ensure that both sampling time
and S/N are reasonable.

· Minimum number of samples sets a lower limit on the oversampling for each point. This applies in
cases where the S/N is extremely high (e.g. due to very high light level or strong CD signal). Setting a
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lower limit avoids accumulating a very small number of samples when doing so would not impose any
real overhead in terms of acquisition time for a single spectral point. By default, this is set to 100.
· Maximum number of samples sets an upper limit on the oversampling for each point. This applies

in cases where the S/N is extremely low (e.g. due to very low light level or weak CD signal). Setting an
upper limit avoids imposing a significant overhead in terms of acquisition time for a single spectral
point. By default, this is set to 4,000,000.

The Detector Target Voltage panel allows two settings:

· Default: the DC target voltage is set to 8 V, which enables measurement of CD over the range -
1200 mdeg to +1200 mdeg. This is the standard range which should be used for most normal CD
applications.
· Low: The DC target voltage is set to 1.5 V, which enables measurement of CD up to an extended

range of -6000 mdeg to +6000 mdeg. This should only be used in applications where very high CD
values are to be measured, as the resolution for smaller CD values (i.e. in the standard range) will be
reduced.

When the HV on a PMT detector (Chirascan VX only) drops below a certain value (via the AutoPM
procedure), its response becomes nonlinear, leading to measurement inaccuracies. When this happens,
a warning message is invoked (although the experiment can be continued if desired). The PMT low HV
warning limit defines the PMT HV value below which this occurs. The default value is 230 V and cannot
be changed.

Clicking Save will retain any changes made even after the software is closed down.

8.2.3.6 The Sequencer Panel

The Sequencer panel (Figure 43) allows you to specify the type of measurement you will make and to
control the starting, stopping, pausing and resuming of data acquisitions. Tick the Repeats check box
to run repeat acquisitions, and enter the number of repeats in the adjacent input box or choose one of
the given numbers from the drop-down menu. A delay between individual acquisitions can be set by
ticking Timed intervals, which is the time between the beginnings of successive repeats; if it is set to
be shorter than the time for each run, then each run will begin after the previous one without delay. All
data from repeat runs will be written to a single file. 

Figure 43: The Sequencer panel

The radio buttons allow you to select the sequencing mode. It will usually be Spectrum for equilibrium
measurements. Kinetics mode is used to follow spectral changes over time and Spectra-Kinetics
mode is used only in conjunction with the Chirascan Stopped-Flow accessory. When Kinetics or
Spectra-Kinetics mode is selected, the Sampling panel is replaced by the Trigger and Timebase
panels .

Click Acquire to begin an acquisition according to the settings in the SCP; clicking Stop (which
appears after Acquire has been clicked) will abort the acquisition; clicking Pause will stop the
acquisition without aborting and Resume (which appears after Pause has been clicked) will restart the
acquisition from the point at which it was paused.
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8.2.3.7 The Progress and Status Panel

The Progress and Status panel (Figure 44) provides information concerning the current status of the
spectrometer and of data acquisition. The box on the left of the panel will give the status (e.g. Ready,
Stirring, Acquiring); the two bars to the right of the panel give a visual representation of the progress
(upper bar: total acquisition progress at each step, lower bar: sampling progress).

Figure 44: The Progress and Status panel

8.2.4 Configuring Temperature Settings

8.2.4.1 The Temperature Control Unit Panel

Depending on the target measurement temperature, the Single Cell Peltier
Holder, cuvette holder and cuvette may be very hot or cold, causing injury to
the user when touched. Ensure that they have been allowed to reach a safe
temperature before handling or use protective equipment (e.g., thermally
protective gloves) if their insertion or removal at extremely high or low
temperature is required. Always use the provided plastic lid for the cuvette
holder  to avoid accidental contact with its top surface if hot. Carry out risk
assessment and consider additional personal protective equipment if in doubt.

Depending on system configuration and experiment design, target

measurement temperature can reach between -20°C and 150°C. Extra care

should be taken when handling a potentially hot/cold cuvette as the target

measurement temperature is actively set through computer control and
monitored only via the Peltier controller display or the control software. As
unsafe temperatures cannot be identified otherwise (e.g., after hard- and
software is switched off or fails), the Chirascan V100 may only be used by, or
under supervision of, trained laboratory personnel familiar with this user
manual and the risks associated with usage of the system and related
procedures, particularly when conducting experiments at elevated sample
temperatures.

The temperature of the sample holder is controlled and monitored on the Temperature Control Unit
panel on the main Chirascan SCP (Figure 45).

Figure 45: The Temperature Control Unit panel

The Single Cell Peltier Holder and some accessories, such as the 6-Cell Peltier Holder, have an integral
Peltier element fitted that can be used to regulate the temperature . When connected, the name of
the Peltier controller will appear in the title of the Temperature Control Unit panel. For further
information see the user manual for the installed device.The temperature shown in the lower box on the
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Temperature Control Unit panel is read from a thermocouple embedded in the Single Cell Peltier
Holder or accessory, i.e. a probe positioned in close proximity to the Peltier element. The temperature is
controlled to this thermocouple.

To set the temperature for isothermal acquisitions, or if you wish to perform a temperature ramp, click
Settings... in the Temperature Control Unit panel to bring up the Temperature Control dialog .

8.2.4.2 The Sample Chamber Panel

Sample temperature is monitored on the Sample Chamber panel on the main Chirascan SCP (Figure
46).

Figure 46: The sample chamber panel

A read-only in-sample temperature probe  can be installed to monitor the sample temperature directly.
The temperature read from this probe is shown on the Sample Chamber panel if the corresponding
connector, which is typically T1, is selected from the drop-down menu. Note that there may be a
difference of several degrees between the probes in the Single Cell Peltier Holder and the sample, and it
is suggested that the in-sample temperature probe should always be used for temperature readings.
Note that, while T1 to T4 correspond to the connectors in the sample chamber, T5 provides the
monochromator temperature for diagnostic purposes and T6 is not used.

Clicking Setup… opens the Sample and Cell Description dialog  that allows the user to provide
detailed information about sample and cuvette.

8.2.4.3 The Temperature Control Dialog

The Temperature Control dialog is opened by clicking Settings... in the Temperature Control Unit
panel  and is used to to configure temperature ramps  and set the temperature for isothermal
acquisitions.

To set the temperature for isothermal acquisitions, enter the desired temperature on the Set Point (C)
panel and confirm by clicking Set. The other panels on the Temperature Control dialog are for
configuring the settings for temperature-ramp experiments, and are only enabled if the Enable
temperature ramping check box is ticked.

To enable temperature ramping, tick the Enable temperature ramping check box (Figure 47), then
choose the type of temperature ramp . A stepped ramp will be performed if the Enable stepped
ramping check box is ticked, a continuous ramp will be performed if the the check box is not ticked.
For a smooth ramp, the temperature will change continuously at a set rate; for a stepped ramp, it will
change in set increments, taking spectra at each set temperature, and moving rapidly between
temperatures.
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Figure 47: The Temperature Control dialog
 
Radio buttons allow to select if the readings of either an in-sample temperature probe  (In-Sample
Temperature Probe (T1...T4))or the thermocouple of the Single Cell Peltier Holder  or 6-Cell Peltier
Holder  (Temperature Controller) are monitored.

If the Over-write temperature set-points with measured temperatures check box is ticked, the set
temperatures will be overwritten by the temperature of the temperature probe specified on the sample
chamber panel  (usually T1). Note that this happens at the end of the ramp; during the ramp, the
temperature displayed in Chirascan Viewer  on the x-axis will be the target temperature, and on the y-
axis will be the probe temperature.

After enabling and choosing the type of temperature ramp and choosing the correct source of
temperature readings, configure settings to perform a temperature ramp .
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8.2.4.4 Performing Temperature Ramps

Types of temperatue ramps

Three types of temperature ramps can be performed:

· Stepped (multiwavelength): the temperature is changed in steps, and spectra are acquired
isothermally after each step, while the temperature remains constant.
· (Continuous) single wavelength: the temperature is changed at a fixed rate, and the CD or other

signal is monitored at a single wavelength. 
· Continuous multiwavelength: the temperature is changed at a fixed rate and spectra are acquired

while the temperature is changing. 

The Temperature Control dialog  is used to enable temperature ramping, to select if a stepped or
continuous temperature ramp is performed and to select the correct probe for temperature readings. If a
continuous temperature ramp is performed, the settings chosen on the Monochromator panel  and the
Monochromator Scan Setup – Advanced dialog  determine if it is a single wavelength or
multiwavelength temperature ramp. Analysis of data obtained by a continuous multiwavelength
temperature ramp requires the Global Thermodynamic Analysis software by Applied Photophysics.

Data from temperature ramp experiments can be exported  into separate files.

Stepped ramp

A stepped temperature ramp is performed if the aim of the experiment is to investigate the structural
changes that occur within a sample during the ramp, but the temperature at which these changes occur
is of secondary importance. It has the advantage that spectra are acquired isothermally, and as many
spectra as necessary can be acquired at each temperature, but the disadvantage is that it is relatively
time-consuming and that transition temperatures cannot be obtained precisely.

Settings for stepped temperature ramps are configured on the Temperature Control dialog  dialog
(Figure 47).

Settings include the Start and Stop temperatures, the temperature Step and the Settling time and
Tolerance. The Settling time input field specifies a duration for which the target temperature must be
stable within the set temperature Tolerance before isothermal acquisition at the target temperature
starts.

Typical conditions for a stepped temperature ramp for a protein are given in Table 1. Note that the
Tolerance and Settling time are applied at every temperature step.

Table 1: Typical conditions for a stepped temperature ramp

Setting Value

Start Temperature 20°C

Stop Temperature 90°C

Step 5°C

Tolerance 0.2°C

Settling Time 30 s

For a stepped temperature ramp with the above settings, the temperature will move to 20 ± 0.2°C, where
it will be held for 30 seconds. After this time isothermal acquisition begins, on completion of which the
temperature will go to 25 ± 0.2°C, where it will be held for 30 seconds before the next isothermal
acquisition begins. This procedure will continue up to 90°C and result in one or more spectra at each of
the 15 temperatures, depending on the number of repeats set in the Sequencer panel  of the SCP. 
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If the Return Ramp check box is ticked, the process will be repeated from high to low temperature. 

At the end of the ramp, the temperature will go to that specified on the End-of-ramp behavior panel,
and a final spectrum will be taken at that temperature if the Take a final measurement check box is
ticked.

Single wavelength ramp

A single wavelength temperature ramp is used if the aim of the experiment is to investigate the
temperature at which structural changes within a sample occur, but the nature of these changes is of
secondary importance. It has the advantage of being quick and accurate if the correct wavelength is
used, but the disadvantage that information about the nature of the structural changes is lost, and if an
incorrect wavelength is used, any structural changes may be hidden.

Settings include the Start and Stop temperatures, the temperature Step, the temperature ramp Rate
and the Settling time and Tolerance. The Settling time input field specifies a duration for which the
start temperature must be stable within the set temperature Tolerance before the first acquisition
begins. Note that the Settling time is not applied to any temperatures other than the start temperature.
Step refers to the increments of temperature at which an acquisition is performed.

Settings for a single wavelength temperature ramp are configured similarly as for a continuous
multiwavelength temperature ramp. However, acquisitions are performed at a single wavelength instead
of over a wavelength range, as specified in the Monochromator Scan Setup – Advanced dialog .

During the temperature ramp, the temperature is increased continuously with the rate specified in the
Rate input field. The time interval between acquisitions corresponds to the step divided by the
temperature ramp rate. For example, if a step of 5°C and a temperature ramp rate of 1°C per minute are
chosen, then an acquisition will be performed every five minutes. 

The acquisition settings are usually configured such that the total acquisition time is a bit less than the
time interval of acquisitions. For a single wavelength temperature ramp, this means that the time-per-
point  is shorter than the acquisition interval.

For a single wavelength temperature ramp with the settings in Table 1 and a rate of 1°C per minute, the
temperature will move to 20 ± 0.2°C, where it will be held for 30 seconds. Then acquisition at the chosen
wavelength will be performed isothermally. After this first acquisition, the temperature will increase at 1°
per minute and when the temperature reaches 24.8°C (i.e. 25.0°C minus the tolerance of 0.2°C), the
second acquisition will be performed, while the temperature continues to increase at the set rate of 1°C
per minute. When the temperature reaches 29.8°C, the third acquisition will begin, and so on.

Continuous multiwavelength ramp

A continuous multiwavelength temperature ramp is used if the transition temperatures and structural
changes are of equal importance. It has the slight disadvantage that the temperature changes during a
spectrum acquisition, although this is accounted for in the Applied Photophysics Global Thermodynamic
Analysis software.

Settings for a continuous multiwavelength temperature ramp are configured similarly as for a single
wavelength temperature ramp. However, acquisitions are performed over a wavelength range instead of at
a single wavelength, as specified in the Monochromator Scan Setup – Advanced dialog . Note that the
temperature will be increasing at the set temperature ramp rate during acquisition. 
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Again, the acquisition settings are usually configured such that the total acquisition time is a bit less
than the time interval of acquisitions. For a continuous multiwavelength temperature ramp, this means
that the total time required to acquire a given number of repeat spectra - over the chosen wavelength
range and at the chosen time-per-point and step size - is shorter than the acquisition interval. 

If each acquisition takes longer than the acquisition interval, the total number of spectra will be the
same, but spectra will be labeled according to their target temperatures, which will then not correspond
with their start temperatures. To reduce the total acquisition time, wavelength range and time-per-point
should be curtailed.

For a continuous multiwavelength temperature ramp with the settings in Table 1 and a rate of 1°C per
minute, the temperature will move to 20 ± 0.2°C, where it will be held for 30 seconds. Then acquisition of
a first spectrum will be performed isothermally. After this first acquisition, the temperature will increase
at 1° per minute and when the temperature reaches 24.8°C (i.e. 25.0°C minus the tolerance of 0.2°C),
acquisition of the second spectrum will be performed, while the temperature continues to increase at the
set rate of 1°C per minute. When the temperature reaches 29.8°C, the acquisition of the third spectrum
will begin, and so on.

8.2.5 Configuring Stirrer Settings

The magnetic stirrer integrated into the Single Cell Peltier Holder  can be controlled through the
Stirrer setup dialog (Figure 48) which is opened by clicking Stirrer in the sample chamber panel .

Figure 48: The Stirrer setup dialog

For continuous stirring, switch the stirrer on by moving the slider in the Stirrer setup dialog to the right.
Move the slider to the left to switch off the stirrer. Note that the stirrer speed cannot be controlled with
this slider. However, the stirrer speed can be controlled by using the controls on the front of the Peltier
controller .

To enable automatic stirring at the beginning of acquisitons, tick the Automatic stirrer control check
box. The Stirring time (s) is the stirring duration before acquisition and the Settling time (s) is a delay
between stirring and beginning of acquisition. Note that these settings are only applied if the Dual
Syringe Automated Titrator is installed.
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8.2.6 Providing Sample Information

Details about the sample and the cuvette used  can be provided by the user in the Sample and Cell
Descripton dialog (Figure 49) which is opened by clicking Setup... in the sample chamber panel .
Note that any information entered in this dialog are for reference only; they are stored  with the
Datastore, but are not otherwise used by the instrument software.

Figure 49: The Sample and Cell Description dialog

By default, the cell path length in the Sample and Cell Description dialog is
set to 10 mm. If the user does not change this information, it is still saved with
datastores although the actual path length used might be different.

Additional information related to an acquisition can be provided by the user in the Remarks and
Comments dialog (Figure 50) which is opened by choosing Remarks... in the View menu  or by
clicking the Remarks toolbar  icon. The information entered in this dialog is saved with the data
acquired and can be inspected later through the Remarks and Comments dialog  in Chirascan
Viewer .
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Figure 50: The Remarks and Comments dialog
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8.2.7 The Preferences Dialog

Clicking on the Preferences icon in the toolbar  or selecting Preferences… from the Configuration
menu  opens the Preferences dialog and contains seven tabs which are described in the following.

8.2.7.1 The Viewer Tab

On the Viewer tab (Figure 51) the appearance of Chirascan Viewer  when launched can be controlled
(with or without a blank display), and whether or not the display automatically rescales when a data
point is measured that is outside the limits of the currently displayed y-axis.

Figure 51: The Viewer tab
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8.2.7.2 The CD Tab

On the CD tab (Figure 52), preferences for CD measurements can be set. In the Default Mode panel,
select either delta A (delta absorbance) or millidegrees as the units for expressing circular dichroism.
In the Auxiliary Measurements panel, the HV check box is disabled and permanently selected, i.e. the
emulated detector HV will always be recorded in CD mode. In the AutoAbsorbance panel the Enable
AutoAbsorbance by default check box can be ticked so that by default, Absorbance will always be
recorded together with the CD signal, which is recommended.

Figure 52: The CD tab
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8.2.7.3 The Absorbance Tab

On the Absorbance tab (Figure 53), preferences for absorbance measurements can be set. The Default
Mode panel enables you to choose between Absorbance and Transmission as the default measured
property. 

In the Auxiliary Measurements panel, the HV check box is disabled and permanently selected, i.e. the
emulated detector HV will always be recorded in Absorbance mode. The Temperature check box is
disabled and selected if the Peltier Controller is installed.

In the Default Options panel, the AutoPM check box enables automatic optimization of the emulated
detector HV at each point in the spectrum; if the AutoPM check box is unticked, the emulated HV is
constant and there is no risk of hysteresis associated with sharp changes in the emulated HV. This will
normally result in a more accurate absorbance measurement, but you must be careful to ensure that the
detector is not saturated during the measurement. However, as occurrence of big changes in emulated
HV from one point to the next are unlikely with AutoPM ticked, using AutoPM will not degrade the
absorbance measurement in any significant way and is recommended.

Figure 53: The Absorbance tab
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8.2.7.4 The Fluorescence Tab

There are no active panels on the Fluorescence tab.

8.2.7.5 The Data Acquisition Tab

The conditions on the Data Acquisition tab have been established as optimal by Applied Photophysics’
engineers, and they should not be changed except under guidance from Applied Photophysics Customer
Support.

The Spectrum/Spectra-Kinetics Mode Options panel includes input fields for acquisition delay times.
Use of delays can, for example, allow time for the detector or other electronic devices to settle, resulting
in more stable acquisition of data.

· Per-point acquisition delay (ms): A delay before each data point
· Pre-scan delay (ms): A delay at the beginning of acquisitions
· Post-scan delay (ms): A delay at the end of acquisitions

The settings in the Detector protection panel ensure that the detector cannot be damaged by being
exposed to too much light while an emulated  detector voltage is applied:

· PMU saturation detection: this function is only used for Chirascan systems using a PMT detector.
· Zero HVs before spectrum scan: If checked, the the emulated detector HV will be set to zero before

acquisition. This way, the AutoPM  procedure begins at zero volts and ramps upwards safely to the
HV level required, rather than starting from a HV level which is potentially too high and could lead to
detector damage.
· Zero HVs on fly-back (spectrum mode): If checked, the emulated detector HV will be set to zero at

the end of acquisition, before the monochromator moves back to the starting wavelength. This avoids
exposing the detector to excessive light during fly-back which is inappropriate for the HV level set on
the final point of acquisition, and could cause detector damage.

 The settings in the DAQ Calibration panel refer to data acquisition:

· Calibrate zero offset errors at program startup: If checked, a procedure to zero residual electronic
offsets will be run when the Chirascan software starts up. Electronic offsets can cause small errors in
data acquisition, so checking this box is recommended.
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8.2.7.6 The File Names Tab

The File Names tab provides functionality identical to the File Names dialog  which can be accessed
directly using the File names icon on the toolbar  of the SCP . Clicking Reset All sets all running
numbers to zero.

Figure 54: The File Names tab
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8.2.7.7 The Startup Preferences Tab

On the Startup Control Panel Mode panel of the Startup Preferences tab (Figure 55), the SCP can
be set to open in Spectrum, Kinetics or Spectra-Kinetics sequencer modes . The Spectrum mode
is usually set as default. 

On the Emulation panel, Chirascan Control can be set to open by default in Emulation Mode , which
can be used for data manipulation on a PC remote from the spectrometer, or with the spectrometer
powered off.

Figure 55: The Startup Preferences tab
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8.2.8 The Device Window

Select Devices… from the View menu  to open the Device Window (Figure 56). Many of the icons
require a service password or are not available, and their action is not described here. Others are only
active when a particular accessory (e.g., the Total Fluorescence accessory and the Scanning Emission
Monochromator accessory) is installed, and the user is referred to the relevant user manual. Only the
buttons and the Attenuator and Circulator icon are described below.

System Reset will reset any user-adjustable parameters accessible through the Device Window to
their factory defaults. It is unlikely that you would need to do this.

Calibrate Zero Offsets will adjust the electronic offset to take into account any small drift that may have
occurred over time. It is unlikely that you will need to do this on a regular basis. The offsets should not
be changed until the instrument electronics are at their normal working temperature (it is good practice
to leave the electronics powered on at all times) nor should they be changed part-way through a series of
measurements, since recalibrating the offsets may shift the CD background slightly.

Service Password… opens a dialog that permits you to change the password that gives access to the
advanced sections of the Device window. If you change it, do not forget it because Applied Photophysics
engineers will not be able to recover it for you.

Figure 56: The Device window
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8.2.8.1 The Attenuator Icon

Clicking the Attenuator icon  opens the Attenuator / Shutter Control dialog (Figure 57).

The attenuator operates both as attenuator and shutter. The Open and Close buttons have the same
function as those found in the SCP  and are linked to them; changes in one set are replicated in the
other. 

The maximum opening of the attenuator can be limited using the slider bar and this may be appropriate
in special circumstances (for example to reduce damage to samples) but in general the attenuator
should not be limited in its maximum aperture. The status of the aperture is shown on the Current
attenuator position slider; if the maximum aperture is limited, then that is also shown in the slider
position. The shutter display on the SCP is linked to this function and therefore the status of the
attenuator can be ascertained from there, too.

Figure 57: The Attenuator / Shutter Control dialog
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8.2.8.2 The Circulator Icon

Double-clicking the Circulator icon  displays the Circulator or Peltier Temperature Control
Unit dialog (Figure 58). This dialog is used to reestablish the connection between the Single Cell Peltier
Holder control module or another Peltier control unit and the computer, for example, after another Peltier
controller of an accessory has been in use before.

Figure 58: The Circulator or Peltier Temperature Control Unit dialog

Select Quantum Northwest Peltier from the drop-down list and click Connect to search for the computer
USB port. When the port has been located, click Assign, and Set as default if required. The software
must be run as administrator for these changes to take permanent effect.

The temperature limits of the Single Cell Peltier Holder are also set on this dialog. These are software
limits that are set to prevent the Single Cell Peltier Holder from overheating or overcooling, for example to
prevent a sample from boiling or freezing. The limits can be changed if required.

8.2.9 The Chirascan Control Menu Bar

Much of what is available in the menus is more readily accessible from the icons in the toolbar .

8.2.9.1 The File Menu

The File menu (Figure 59) gives access to the options below for handling templates. The examples
folder can be accessed from this menu, in which there are several examples of spectra  supplied by
Applied Photophysics that can be used as templates to set up Chirascan Control or as tools to
familiarize oneself with the use of Chirascan Viewer .
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Figure 59: The File menu

· Open… sets the acquisition settings according to an opened file.
· Open Examples… sets the acquisition settings according to one of the example files  
· Save Template as… brings up a dialog that allows saving the current acquisition settings as a new

file.
· Exit closes the Chirascan Control software.

8.2.9.2 The View Menu

The View menu (Figure 60) gives access to the following options:

· Pro-Data Viewer… launches Chirascan Viewer .
· Devices… opens the Device window . This contains a number of icons corresponding to hardware

devices that may need to have certain parameters adjusted.
· Remarks… opens the Remarks and Comments  dialog, in which you can record information about

your experiments.
· Toolbar toggles visibility of the toolbar .
· Always on top toggles Chirascan Control to be always visible.
· Run silently is used to suppress error and warning messages, for example the detector low HV

warning, that would pause acquisition when displayed.

Figure 60: The View menu

8.2.9.3 The Configuration Menu

The Configuration menu (Figure 61) gives access to the following options:

· Change sample chamber Unit opens the Select sample chamber Unit dialog. Unless the
Stopped-Flow accessory is fitted, Standard sample chamber should be selected in this dialog.
· Access Control… opens a panel showing the names of members of security groups with access to

the Chirascan software.
· Preferences... opens the Preferences dialog  in which personal preferences can be set.
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Figure 61: The Configuration menu

8.2.9.4 The Help Menu

The Help menu (Figure 62) gives access to the following options:

· Help Topics launches this user manual. You can browse the contents and search for specific words
and phrases.
· About Chirascan… opens a window giving the version number and other information about Chirascan

Control.

Figure 62: The Help menu

8.2.10 The Chirascan Control Toolbar

The Chirascan Control toolbar is shown in Figure 63. Most of the toolbar actions duplicate some of those
of the menu bar  options.

· New sets the acquisition settings to default values.
· Open… sets the acquisition settings according to an opened file.
· SaveTemplate As... saves the current acquisition settings as a new file.
· File Names opens the File Names dialog , in which you can specify seed names for spectra and

backgrounds.
· Remarks… opens the Remarks and Comments  dialog, in which you can record information about

your experiments.
· Preferences... opens the Preferences dialog  in which personal preferences can be set.
· Pro-Data Viewer launches Chirascan Viewer .
· ANMS opens the ANMS software .
· About opens a window giving the version number and other information about the Chirascan Control

software.
· Help launches the context-sensitive help; the mouse pointer changes to an arrow with a question

mark and allows you to click on a user interface element to open the corresponding topic of the
Chirascan Control help system.

Figure 63: The Chirascan Control toolbar
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8.3 Chirascan Viewer

This section describes the Chirascan Viewer program, which is designed to display and manipulate data
and to store them securely.

8.3.1 Introduction

8.3.1.1 Launching Chirascan Viewer

Chirascan Viewer is designed to display live data while a measurement is running, to store the data
securely on completion of the experiment, and to reload, plot and manipulate the stored data at any time
later.

On completion of a measurement, the data are stored as .dsx files. These can be reloaded from their
location in the Microsoft Windows file system into Chirascan Viewer for plotting and manipulation; the
manipulated files can then also be saved.

Chirascan Viewer can be used either online, with a client-server link to Chirascan Control, or off-line as a
standalone program without such a link.

Chirascan Viewer is launched on-line from the Chirascan Control SCP  by right clicking on the Pro-
Data Viewer icon in the SCP toolbar . The link between Chirascan Control and Chirascan Viewer will
be established automatically. When on-line, Chirascan Viewer becomes a live display for data as they
are collected, although it can still be used for the display and manipulation of other data. 

Chirascan Viewer is launched off-line, i.e. without a link to Chirascan Control, for data display and
manipulation only by double-clicking its desktop icon. Note that in this case Chirascan Control will not
know of its existence, and Chirascan Viewer will not respond to the start of an experiment in the normal
way. However, a connection between the two programs can be established by using Go-Online.. in the
Preferences menu  of Chirascan Viewer.

The status of Chirascan Viewer is shown on the status bar  at the foot of the launchpad , where the
words Ready (On-line) or Ready (Off-line) can be found (Figure 64). If Chirascan Viewer is off-line and
you wish to change its status to on-line, i.e. establishing the link to Chirascan Control, this can be done
in the Preferences menu .

8.3.1.2 The Chirascan Viewer Window Layout

The Chirascan Viewer window layout (Figure 64) follows Microsoft Windows conventions.

Chirascan Viewer opens with one or more windows:

· The launchpad, which shows a list of the files in the current folder.
· The Graphical Display  where data are plotted.

The top of the launchpad contains the launchpad menu bar  and the top of the Graphical Display
contains the Graphical Display menu bar .

Moreover, there are several toolbars present in Chirascan Viewer:

· The Standard toolbar at the top of the Graphical Display  is used for standard Microsoft Windows
functions.
· The Analysis toolbar at the top of the Graphical Display  is used for various operations  of data

analysis.
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The bottom of the launchpad contains a status bar that displays the on-line status  of Chirascan
Viewer.

Multiple instances of the Graphical Display  may be present in parallel if multiple data files have been
opened. However by default, Chirascan Viewer launches without a Graphical Display . This behavior
upon launch can be changed through the View tab  in the Preferences dialog  of Chirascan
Control .

Figure 64: The Chirascan Viewer window

8.3.2 The Launchpad File List

Measurement data can be browsed using the tree view of the launchpad file list and are stored as .dsx
files in the Microsoft Windows file system. Data can be exported , for example for use with third-party
programs such as Microsoft Excel™, or for handling on a remote computer. 
Multiple entries in the file list can be selected by clicking the first and last entry with the left mouse
button + Shift. Single entries can be added to the selection by using the left mouse button + Ctrl. A
toolbar above the launchpad file list (Figure 65) assists in navigation and allows browsing, adding and
renaming folders. Most of the functions of these icons for navigation in the file list are also available
through the Directory menu  in the Launchpad menu bar . 

Figure 65: The file list navigation toolbar
 
· Set Working Directory sets the currently selected directory as the current Working Directory .
· Back to the Working Directory navigates to the current Working Directory .
· Move Up navigates to the directory one level above the current directory.
· New Folder creates a new folder in the current directory.
· Browse opens a dialog that allows browsing for a specific directory.
· Refresh updates the file list for any recent changes (e.g. a newly created file).
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· Help. launches the context-sensitive help; the mouse pointer changes to an arrow with a question
mark and allows you to click on a user interface element to open the corresponding topic of the
Chirascan Control help system.

The current Working Directory  is shown above the icons for file list navigation. The Windows drop-
down menu above the current working directory can be used to give focus to any instance of Graphical
Display  that is currently opened.

8.3.2.1 The Datastore File Structure

Measurement data are written to a results file called a Datastore, which is a proprietary format designed
for handling multi-dimensional data. Its content depends on the type of measurement that is carried out.
A knowledge of the structure of Datastores is helpful for understanding some of the functionality of
Chirascan Viewer .

A Datastore contains all the data from a measurement, as well as measurement settings such as
wavelength range, bandwidth, sampling times, etc. It can also include remarks and other information
input by the user for reference.

The measurement data contained in a Datastore consists of dimensions and properties. The dimensions
are the controlled (independent) experimental variables, such as wavelength or time; the properties are
the measured (dependent) variables such as CD or absorbance; temperature may be either a dimension
or a property or both, depending on the type of measurement. When data are plotted using Chirascan
Viewer, dimensions are always plotted on the x-axis, and properties on the y-axis. 

A Datastore can therefore have one or more dimensions, depending on the number of controlled
variables. For example, a simple measurement in which CD is measured as a function of wavelength
would generate a one-dimensional Datastore containing wavelength as the dimension, and CD, detector
emulated HV, absorbance (if measured), transmission, temperature, the detector signal voltage (DC
component), and the number of samples taken at each step (count), as properties.

If a temperature ramp is performed in which a series of spectra are measured while the temperature is
changing, a two-dimensional Datastore would result, with wavelength and temperature as dimensions,
and containing CD, HV etc. as properties. A titration experiment with the Dual Syringe Automated
Titrator, in which a spectrum is measured at each of a series of concentrations, would also generate a
two-dimensional Datastore, in this case containing properties as functions of wavelength and titrant
concentration. A dimension is also added if measurements with repeat scans are performed.

Higher dimension Datastores can also be generated. If a stepped temperature ramp is carried out using
the 6-Cell Peltier Holder, then cell position becomes a third dimension and the Datastore contains
properties as functions of temperature, wavelength and cell position. Substituting time for temperature
would result in a Datastore containing properties as functions of wavelength, time and cell position. All
data from a particular measurement are written to a single Datastore. Subsequently, the Datastore can
be mined for subsets of the data.

Note that the Datastore file format is designed for Chirascan software multi-dimensional data acquisition
and is not suitable for direct access outside the Chirascan software environment. A range of file export
options is provided within Chirascan Viewer, generating formats that are suitable for third-party software.

8.3.2.2 Viewing Datastore Information

Acquisition settings, sample information provided by the user and additional user information are stored
with the data and can be viewed on the Datastores Details view, the area to the bottom of the Launchpad
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(Figure 66). The details shown will be those corresponding to the Datastore currently selected in the file
list and the current selection in the Selected File DataStores sub-panel . 

Figure 66: The Datastores Detail View

Further Datastore information is available through the View menu :
 
· Remarks... opens the Remarks and Comments dialog (Figure 67) which shows information entered

for reference by the user in the Remarks and Comments  dialog in the SCP , sample information
provided by the user via the Sample and Cell Description dialog  (sample description, concentration,
cell type and path length) and supplement information that has been recorded automatically such as
the instrument serial number.
· History... opens the History dialog (Figure 68) which shows the time and date stamps and the results

of operations  performed on the data (such as baseline subtraction, smoothing, curve fitting etc.).

Some of the information shown in the Datastores Details view or additional information is also available
by other means:

· Choosing Properties in the Datastore right-click menu
· Choosing DataStore Info... in the View menu  to open the DataStore Information dialog
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Figure 67: The DataStore Information dialog

Figure 68: The Remarks and Comments dialog
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Figure 69: The History dialog

8.3.2.3 The Datastore Right-Click Menu

Right-clicking on a file calls up the context menu shown in Figure 70.

Figure 70: The DataStores right-click menu

The Datastore right-click menu gives access to context-sensitive functions that are enabled or disabled
depending on whether a Datastore or a folder has been right-clicked.
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The following functions are enabled for folders only:

· Set Working Directory Here sets the right-clicked folder as the Working Directory .
· New Folder creates a new folder within the right-clicked directory.

The following functions are enabled for Datastores only:

· Open brings up a new instance of the Graphical Display  with a plot for the right-clicked Datastore.
· Export Data... allows storing  the right-clicked Datastore in a format that is suitable for use with

third-party programs.
· Decompose Data... opens a dialog that allows extracting subsets of data from a multi-

dimensional  Datastore.
· Temperature Ramp Data... opens a dialog that allows extracting temperature ramp  data in

seperate files for each temperature and/or wavelength.
· Delete removes the right-clicked Datastore(s).

The following functions are enabled for both Datastores and folders:

· Browse with Explorer... opens a dialog that allows browsing for a specific directory.
· Rename allows renaming the right-clicked Datastore. This option is disabled for the Working

Directory .
· Properties opens a dialog showing the file properties for the right-clicked Datastore.

8.3.3 The Graphical Display

The Graphical Display is used to display and manipulate traces. Traces can be spectra (i.e. wavelength-
dependent properties), kinetic traces (i.e. time-dependent properties), melting curves (i.e. temperature-
dependent properties) or other data.

8.3.3.1 Viewing Traces

The Graphical Display uses a Multiple Document Interface (MDI) format: multiple Datastores can be
open at the same time as instances of the Graphical Display, in each of which multiple plot windows can
be opened simultaneously to display different properties . The active instance is selected either by
clicking the instance or from the Windows drop-down menu in the Launchpad .

Data from one or more Datastores can be displayed in each plot of the Graphical Display:

· To plot a Datastore in a new window, double-click on the Datastore, right-click  on the Datastore
and click Open, or choose Open from the File menu .
· To add a Datastore to a Graphical Display, drag it onto the plot from the file list.
· To add more Datastores to a Graphical Display, select multiple Datastores from the list in the usual

way (using the left mouse button with Ctrl or Shift keys) and drag them onto the Graphical Display
(Figure 71).
· To remove a trace from the display select  the trace, right-click and choose Remove Selected

Trace(s), press the Del key, or use the Trace manipulation dialog .
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Figure 71: Data of two datastores (buffer and protein) displayed in the Graphical Display

8.3.3.2 Overlaid Traces

Displaying multiple Datastores in the same plot by drag-and-drop  is useful for comparing traces.
However, note that two Datastores must be compatible with each other to be displayed in the same plot
– for example, a trace collected as a function of wavelength cannot be displayed together with a trace
that was collected as a function of some other dimension , such as temperature.

It is possible to add traces to a plot the property and dimension (e.g. CD and wavelength) of which are
compatible with the traces already displayed, but that differ in wavelength range, step size or bandwidth.
Such overlaid traces cannot be manipulated and are always colored black to differentiate them from
other traces.

8.3.3.3 Showing and Hiding the Legend

Plots open with a legend containing a list of the plotted traces to the right of the plot area. To hide or
show the legend, right-click on the area to the right of the graph and choose Hide/Show Legend or
choose Legend in the View menu .

8.3.3.4 Showing and Hiding the Error

If data has been acquired with calculation of the standard error  enabled, the standard error can be
displayed as an error band and/or as error bars (Figure 72). The standard error is calculated  based on
the number of samplings. Note that display of the standard error is limited to CD data and plots without
overlaid traces .
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Figure 72: Error Band (left) and Error Bars (right)

Visibility of error band and error bars is controlled through the View menu  of the Graphical Display:
click Error and toggle either Error Band or Error Bar or both, and then choose the number of Standard
Errors for the error range in the Uncertainty sub menu (Figure 73).

Figure 73: The Error menu and Uncertainty sub menu

8.3.3.5 Selecting a Trace

A trace can be selected in a number of ways. Once selected, it changes color to black, is highlighted
with ‘selection marks’ and crosshairs appear on it. The value of the x- and y-coordinates at the position
of the crosshairs are shown above the plot (Figure 74). Single trace selection methods are listed below.

· Place the mouse cursor close to a data point of the trace of interest. Left-click to select it. Click a
second time to deselect it.
· Right-click anywhere in the Graphical Display to open a context menu . Choose Select Specific

Traces to open a dialog containing a list of the traces displayed. Click on an entry to select it and OK
to close the dialog.
· On the Trace menu  click Selection Dialog… or from the Analysis toolbar  click on the Select

Traces icon to open the Trace Manipulation dialog . Click on an entry to select it and OK to close
the dialog.
· Select an entry from the drop-down menu at the top of the Graphical Display.
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Figure 74: Protein CD spectrum with buffer baseline selected

The method of selection will depend on personal preference and on the number of traces displayed. For
example, if you wish to select one trace from several overlapping traces, using the dialog is easier than
using the mouse pointer. Once a trace is selected, the Up / Down arrow keys can be used to move the
selection sequentially through the displayed traces.

8.3.3.6 Selecting Multiple Traces

Selecting more than one trace is often required, for example, to average several spectra. Variations in
the methods to select a single trace  are used to select more than one.

· Using the mouse pointer: Hold down the Ctrl key and left-click on a trace to toggle its selection
status.
· Using the trace list: Hold down the Ctrl key and left-click on a trace name in the drop-down menu

above the plot to toggle its selection status.
· Using the Trace manipulation dialog : Hold down the Ctrl key and left-click on a list entry to toggle

its selection status; hold down the Shift key and left-click two list entries to select a set of entries;
alternatively, left-click and drag the mouse pointer over the list to select a set of entries. Selected
entries are highlighted. In general, using the dialog is the preferred method when dealing with more
than one trace.

8.3.3.7 Zooming and Rescaling the Display

To zoom in to a particular part of the display, click and hold the left mouse button while moving the
pointer to create a box around the area of interest. On releasing the left mouse button, the newly created
box will expand to fill the display window (Figure 75). To return to full display, double-click in the display
area or click Reset Zoom in the Scale menu .
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Figure 75: Full display with zoom box (left) and zoom (right)

Use the mouse wheel to increase or decrease the displayed ranges of both axes simultaneously. Hold
down the Ctrl key and use the mouse wheel to increase or decrease the displayed range of only the
horizontal axis. Likewise, hold down the Shift key and use the mouse wheel to increase or decrease the
displayed range of only the vertical axis (Figure 76).

Figure 76: Zooming horizontal axis (left) and vertical axis (right) only

The displayed area can be specified by setting lower and upper limits for the x- and y-axis in the Select
Range dialog, which is opened by choosing Set Plot Limits... in the Scale menu .

8.3.3.8 Changing the Displayed Property

Chirascan Viewer always plots the dimension  on the x-axis, and a selected property  on the y-
axis. Right-clicking the y-axis legend will display a menu of the properties recorded during a
measurement (Figure 77). To change the plotted property, select one from the list by double-clicking it.

Figure 77: The properties menu
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When run in CD mode , five properties are recorded with every measurement made on the
spectrometer. These are:

· Circular dichroism
· HT (High Tension, i.e. HV, detector emulated high voltage input)
· Voltage (detector DC voltage output)
· Temperature at which the measurement was taken
· Count (the number of samples  taken at each step in the scan)

In addition, the absorbance can be plotted if it was selected when setting the acquisition settings  and
a background  has been run. Fluorescence can be plotted if it was selected and a suitable
fluorescence accessory was fitted (see the user manual for the relevant fluorescence accessory).

8.3.3.9 Displaying Multiple Properties

Only one property can be plotted on each plot, but two properties can be viewed simultaneously on
different plots. On the Window menu , click New Window and select a property from the list that is
displayed. The Graphical Display will appear as in Figure 78, which shows the same data plotted as
circular dichroism against wavelength in the upper plot, and absorbance against wavelength in the lower
plot.

Figure 78: Plots of circular dichroism and absorbance plotted against wavelength

8.3.3.10 The Graphical Display Right-Click Menu

Right-clicking on the plot area of the Graphical Display opens the menu shown in Figure 79.

This context-sensitive menu gives access to different options depending on whether a trace is currently
selected in the Graphical Display or not. These options are also accessible in other menus or toolbars in
Chirascan Viewer and include: 

The following functions are available no matter if a trace is selected or no:
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· Select All Traces is similar in function to Selected All in the Trace menu  and the Trace
Manipulation dialog .
· Unset Baseline is only enabled if a baseline is currently set.
· Print… is similar in function as in the File menu  and Print the Current Plot in the Standard

toolbar .
· Reset View is similar in function as Reset in the Trace menu .

 
Figure 79: The Graphical Display right-click menu with no (left) and a single trace selected (right)

The following functions are available only if no trace is selected:

· Select Specific Traces... is similar in function as Selection Dialog... in the Trace menu  and
Select Traces in the Analysis toolbar .
· Select Range... is similar in function as Select Trace Range in the Analysis toolbar  and Thin

Data in the Trace Manipulation dialog .
· Average All Traces is similar in function as in the Math menu  and Select All Traces and Only

Show Average in the Analysis toolbar .
· Remove Overlaid Traces is similar in function as in the Trace menu  and the Analysis toolbar .
· Recompute Colours is similar in function as in the Analysis toolbar  and the Trace menu .

The following functions are available only if a trace is selected:

· File contains sub entries Save Selected and Save Current Plot... as in the File menu .
· Deselect All is similar in function as in the Trace menu  and the Trace Manipulation dialog .
· Remove Selected Trace(s) is similar in function as in the Trace menu  and Remove in the Trace

Manipulation dialog .
· Remove Unselected Trace(s) is similar in function as in the Trace menu  and Remove Others

the Trace Manipulation dialog .
· Set Selected as Baseline sets a single selected trace as baseline and is similar in function as

Toggle Selected as Baseline in the Trace menu  and Set Baseline the Trace Manipulation
dialog .
· Add Baseline is similar in function as in the Trace menu  and Add Baseline to Selected Traces

the Analysis toolbar .
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· Subtract Baseline is similar in function as in the Trace menu , the Trace Manipulation dialog
and Subtract Baseline from Selected Traces the Analysis toolbar .
· Math with its sub entries is similar in function as in the Math menu .
· Convert CD units… allows converting  CD data into other units as in the Analysis toolbar  and

as Convert... in the Math menu  and the Trace Manipulation dialog .

8.3.3.11 The Standard Toolbar

Most of the icons of the Standard toolbar (Figure 80) are used to perform standard Microsoft Windows
functions or to inspect Datastore information .

Figure 80: The Standard toolbar

· Save the Current Plot opens the Save As dialog that allows you to save  the active plotwith all
settings and data, including hidden traces.
· Print the Current Plot opens the Print dialog that allows printing the active plot. 
· View Info opens the DataStore Information dialog .
· View Remarks opens the Remarks and Comments dialog .
· View History opens the History dialog . 
· Help. opens the context-sensitive help; the mouse pointer changes to an arrow with a question mark

and allows you to click on a user interface element to open the corresponding topic of the Chirascan
Control help system.
· About opens the About Chirascan Viewer dialog, which gives the version number and other

information about Chirascan Viewer.

Some of the functions of the Standard toolbar are also accessible through the File menu  or the right-
click menu  of the Graphical Display.

8.3.3.12 The Analysis Toolbar

The Analysis toolbar (Figure 81) is used for data analysis  and gives access to the following options:

Figure 81: The Analysis toolbar

· Toggle Selected Trace as Baseline sets / unsets a selected trace as a baseline.
· Add Baseline to Selected Traces becomes enabled once a baseline has been set and adds the

baseline to one or multiple selected traces. It is useful if a baseline has been subtracted inadvertently
from a trace.
· Subtract Baseline from Selected Traces becomes enabled once a baseline has been set and

subtracts the baseline from one or multiple selected traces.
· Curve Fitting opens the Curve fitting dialog enabling a model to be fitted  to a selected trace. 
· Average Selected Traces calculates and plots the average of the selected traces.
· Average All Traces and Only Show Average calculates and plots the average of all the traces in

the active plot. The original traces are removed. Removed traces can be recovered using the Trace
Manipulation dialog .
· Arithmetic opens the Simple Math dialog that enables you to apply simple calculations  on

traces.
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· Smooth Selected Traces opens the Smoothing – Savitsky-Golay dialog that allows you to apply a
smoothing  algorithm to one or multiple selected traces.
· Convert CD Units opens the Convert CD Units dialog enabling you to convert  from millidegress or

delta A to other CD units.
· Select Traces opens up the Trace Manipulation dialog .
· Select Trace Range opens the Visible Trace Range dialog that allows removing a subset of traces

as defined by a Start, End and Step for skipped traces as Thin Data in the Trace Manipulation
dialog  and Select Range... in the right-click menu  of the Graphical Display.
· Remove Overlaid Traces removes all overlaid traces .
· Use Logarithmic X-axis Scale toggles the scale of the x-axis between logarithmic and linear. This

feature can be useful when time is plotted on the x-axis, as is the case for kinetic data.
· Recompute Trace Colours will assign new colors to the traces in the plot. This is useful if after trace

manipulation the colors of traces are not satisfactory.

Some of the functions of the Analysis toolbar are also accessible through the Trace menu , the Math
menu  or the Trace Manipulation dialog .

8.3.4 Data Manipulation

8.3.4.1 Trace Manipulation

The Trace Manipulation dialog (Figure 82) can be opened by clicking Selection Dialog… on the
Trace menu , Select Traces in the Analysis toolbar  or clicking Select Specific Traces... in the
right-click menu  of the Graphical Display .

Figure 82: The Trace Manipulation dialog

The dialog is an environment for basic data analysis  in which data (traces) can be baseline corrected,
averaged or otherwise manipulated. All operations carried out within this environment are reversible,
which means that if errors are made they can be quickly and easily corrected. The original data are
never over-written or otherwise destroyed and all operations carried out on data are recorded in the
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History available through the View menu . The results of the manipulations are displayed in real-time
and can be saved  at the end of the session.

The structure of the dialog is straightforward. There are two lists, the Visible Traces list to the right
which contains any traces that are visible in the active Graphical Display , and the Removed Traces
list to the left containing those that have been removed from the Graphical Display  during the session
and are no longer shown. Traces can be swapped between the the two lists using the arrow buttons
between the two lists. The single arrow will move a selection, the double arrow will move all listed traces.

The buttons on the right execute actions on traces that have been selected in the Visible Traces list.
Some of these functions are also accessible in other menus or toolbars in Chirascan Viewer and
include: 

· Select All selects all traces as in the Trace menu  and Select All Traces in the right-click
menu  of the Graphical Display .
· Deselect All deselects all traces as in the Trace menu  and the right-click menu  of the

Graphical Display .
· Set Baseline sets the currently selected trace as the baseline as Toggle Selected as Baseline in

the Trace menu  and Set Selected as Baseline in the right-click menu  of the Graphical
Display . The baseline trace will be indicated as such with '--------- Baseline'. Once a trace has been
set as baseline, the button label will change to Unset Baseline to allow revoking the baseline
selection.
· Subtract Baseline subtracts the current baseline trace from the currently selected trace as in the

Trace menu  and Subtract Baseline from Selected Traces the Analysis toolbar .
· Remove moves the selected trace(s) into the Removed Traces list as Remove Selected Trace(s) in

the Trace menu  and the right-click menu  of the Graphical Display .
· Remove Others moves the unselected trace(s) into the Removed Traces list as Remove

Unselected Trace(s) in the Trace menu  and the right-click menu  of the Graphical Display .
· Thin Data opens the Visible Trace Range dialog that allows removing a subset of traces as defined

by a Start, End and Step for skipped traces as Select Trace Range in the Analysis toolbar  and
Select Range... in the right-click menu  of the Graphical Display .
· Average averages the selected traces as in the Math menu , Math in the right-click menu  of

the Graphical Display  and Average Selected Traces in the Analysis toolbar .
· Simple Maths opens the Simple Math dialog that enables you to apply simple calculations  on

traces as in the Math menu , in the Math sub menu in the right-click menu  of the Graphical
Display  and Arithmetic in the Analysis toolbar .
· Smooth allows smoothing  of traces as in the Math menu , in the right-click menu  of the

Graphical Display  and Smooth Selected Traces in the Analysis toolbar .
· Fit allows fitting  traces with a model as Fitting... in the Math menu , the Math menu in the

right-click menu  of the Graphical Display  and Curve Fitting in the Analysis toolbar .
· Convert... allows converting  CD data into other units as in the Math menu  and the right-click

menu  of the Graphical Display  and Convert CD Units in the Analysis toolbar .

8.3.4.2 Simple Calculations

The Simple Math dialog can be opened by clicking Simple Math… on the Math menu , Arithmetic
in the Analysis toolbar , clicking Simple Math... in the Math sub menu of the right-click menu  of
the Graphical Display , or clicking Simple Maths in the Trace Manipulation dialog .
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Figure 83: The Simple Math dialog

The dialog enables you to add to or subtract a constant from the selected traces or multiply or divide the
selected traces by a constant. It can be useful for offsetting one trace from another for display purposes
or for normalizing spectra for easier comparison.

Other simple data manipulation procedures like averaging or baseline subtraction can be accessed
directly through the Analysis toolbar , the right-click menu  of the Graphical Display , the Trace
Manipulation dialog , or the Math menu .

8.3.4.3 Smoothing

For final presentation of traces, smoothing can be applied to reduce noise. However, it is discouraged to
perform data manipulation for mere cosmetic reasons and data manipulation that is followed by
quantitative analysis should only include averaging and baseline subtraction.

To smooth data, first select  the trace(s) you wish to smooth and then open the Smoothing -
Savitsky-Golay dialog (Figure 84) by choosing Smooth... either in the Math menu , the Analysis
toolbar , the Trace Manipulation dialog  or in the Math menu in the right-click menu  of the
Graphical Display .

Smoothing is achieved with a Savitzky-Golay filter. For each data point in the original trace, this filter fits
the data within a certain data interval centered at this data point with a low-degree polynomial by the
method of linear least squares. The value of the fit function obtained for this data point is then used for
the smoothed trace. The value of the Window Size input field corresponds to the number of data points
on each side of a data point that are used for the fitting procedure.

This value will depend on the step resolution used during the measurement and the sharpness of the
features in the trace. The number should be as large as possible without causing distortion of the trace.
Examination of the residual plot will show if any distortion has occurred. If the noise is randomly
distributed about zero, the smoothing process has not caused any distortion and, importantly, you have
the evidence to prove it. 

An example of an appropriate smoothing, in which a window of 5 data points was used, and an
inappropriate one, in which a window of 12 data points was used on the same data set, are shown in
Figure 84. The structure in the residuals that arises when a window size of 12 was used indicates that
the example spectrum has been oversmoothed.
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Figure 84: An appropriate smooth (left) and an inappropriate smooth (right)

If you want the original trace(s) to be replaced by the smoothed trace(s), tick the Replace original
data with smoothed check box; however, it is recommended to always keep the original data. If you
keep the original data, you can choose to tick the Save Residual On Graph check box to obtain the
residuals as an additional trace in the Graphical Display . When you are satisfied with the smoothing
process, click OK. The smoothed trace will be labeled Smooth (s): 0, and the residuals will be labeled
Smooth (r): 0.

8.3.4.4 Curve Fitting

To apply a fit to a trace, first select  the trace and then open the Curve Fitting dialog either by
choosing Fitting... in the Math menu , in the Math menu in the right-click menu  of the Graphical
Display , in the Analysis toolbar  or Fit in the Trace Manipulation dialog .

A model is fitted to the data using a Marquardt-Levenberg algorithm. Select the required function from
the drop-down list on the Fitting Parameters panel and enter the range over which the data are to be
fitted on the Fit Range sub-panel, then click Set to confirm. If you are unsure about initial starting
parameters for the fit, click Estimate to automatically generate a set of initial parameters, which may
not be very accurate. The curve associated with these parameters is plotted in the preview panel to the
right.

To initiate the fitting of the parameters to the data, click Fit. The algorithm will iterate until convergence
or the maximum number of cycles is reached. If the fitting is successful, the parameters will be updated
and the calculated curve plotted in the preview panel. The associated residual trace (the difference
between the observed and calculated data) will be displayed in the Residuals part of the preview panel.
The errors associated with the calculated parameters are displayed next to the calculated parameters.
You will be able to judge the quality of the fit by inspecting the residual trace and the parameter errors. If
the errors are large compared with the parameters, then it is likely that you have specified a fitting
function which contains too few parameters to adequately describe the data, i.e. the model is
underfitted. 

The number of variable parameters can be reduced by locking any parameter using the check boxes
adjacent to the parameters (to set them as invariable, fixed parameters), but such locking must be
justified and should be applied with care. Note that Estimate should not be clicked after locking
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parameters as this will unlock and yield new estimates for all parameters. Locking a single parameter
and fitting repeatedly for different fixed values of this parameter can help to evaluate the suitability of the
fitting function; if this procedure does not result in a substantial increase of the RMS (root mean square),
this could indicate an overfitted model, i.e., a model that contains more parameters than justified by the
data.

If the fitting process does not converge within the selected maximum number of iterations, a warning is
given. You may wish to increase the number of iterations, up to a maximum of 1000. Be aware that 1000
iterations of the fitting algorithm may take some time. In some instances, the fitting does not converge
because of the absence of a unique solution. This too is symptomatic of an underfitted model.

Fitting of kinetic data obtained for the hydrolysis of glucuronolactone with potassium hydroxide with a
single exponential function is shown in Figure 85.

Figure 85: The Curve Fitting dialog

When you are satisfied with the fit, you can print out a report by clicking on the printer icon. The report
displays the data, the calculated fit data with residuals and the associated fitting parameters.

To plot the fitted curve in the Chirascan Viewer display, click OK. If you do not wish the residuals to be
included on the plot, untick the Include Residuals in Final Plot check box.

8.3.4.5 Converting CD Units

To convert CD data into another unit, first select  the trace(s) whose units you wish to convert and
then open the Convert CD Units dialog (Figure 86) by choosing Convert… either in the Math menu ,
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the Trace Manipulation dialog  or in the Math menu in the right-click menu  of the Graphical
Display , or by choosing Convert CD units... in the Analysis toolbar  or the right-click menu  of
the Graphical Display .

Figure 86: The Convert CD Units dialog

The CD units of the selected trace are shown in the Convert From box; the units you wish to Convert
To are chosen from the drop-down menu.

When converting between millidegrees (mdeg) and delta A, a scaling factor is used, and the conversion
requires no further input. When converting from mdeg or delta A to units that are normalized in some
way, further input is required.

To convert to delta epsilon or molar ellipticity the calculation normalizes for (and therefore requires
knowledge of) the Molarity of the solution and the Path Length (cm) of the cell.

For proteins, it is usual to normalize for the number of amino acid residues as well as concentration and
path length. When mean residue delta epsilon or mean residue molar ellipticity are selected, the
input required is the Concentration (mg/ml) of the protein, the Path Length (cm) of the cell used and
the mean residue molecular weight, Residue (MW). The default input for the latter is 113, a commonly
accepted value for the mean molecular weight of an amino acid residue. This default value can be
changed if required. The units are presented in this way to make it possible for proteins that are not yet
fully characterized to be normalized for comparative purposes.

If the sequence and, thus, the number of amino acid residues of the protein is known, the mean
residue ellipticity can be calculated by providing the molar Concentration (M) of the protein, the Path
Length (cm) of the cell used and the Number of amino acid residues.
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8.3.4.6 Handling Multi-Dimensional Data

Plotting multi-dimensional Datastores is controlled using the dimensions menu, which is opened by
right-clicking the label of the x-axis, and a slider bar above the plot (Figure 87).

For a two-dimensional Datastore (e.g. wavelength and repeat), the x-axis corresponds to the
independent variable of the first dimension, which is selected by choosing an entry with the
corresponding label in the X column of the dimensions menu, and the set of traces displayed
corresponds to that of the second dimension, which corresponds to the Z column for the selection in the
dimensions menu.

  
Figure 87: The dimensions menu (left) and slider bar (right)

For a three-dimensional Datastore (e.g., wavelength, repeat and temperature), a slider bar representing
the third dimension is added beneath the Analysis toolbar  in the Graphical Display . Move the
slider bar to choose traces from the third dimension (Figure 87). Any independent variable can be
assigned to any of the three dimensions; therefore, there are six different possibilities to display three-
dimensional data.

Once multi-dimensional data are displayed as described, they can be manipulated  for analysis.

Multi-dimensional files can be decomposed for subsets of the original data and the subsets saved as
new files. The process is recursive, so higher-dimensional files can be reduced to their simplest one-
dimensional forms if required.

To decompose a multi-dimensional file, right-click  on the file in the file list  and select
Decompose Data… from the menu. The Decompose Data dialog appears (Figure 88).

Figure 88: The Decompose Data dialog

The Decompose Data dialog displays all dimensions together with the ranges they span. To trim the
range of an independent variable, provide the desired range limits in the Range Min and Range Max
input fields. To exclude a dimension, untick the corresponding Primary check box. The output will be
split up into separate files for any excluded dimension.
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Click Save as…, name the file, and refresh  the launchpad tree view. A new folder is created in the
specified location containing the original file and a hierarchy of subfolders that depends on the number of
excluded dimensions. For example, if the data contains three repeat scans and repeats are exlcuded,
one subfolder is created containing three file, each corresponding to one of the three repeats. If, for
example, also temperature was excluded, three subfolders would be generated, each corresponding to a
single repeat and containing multiple files, one for each temperature.

8.3.5 Saving and Exporting Data

8.3.5.1 Saving Data

All data is stored in the current Working Directory. The current Working Directory is displayed in the
box above the file list
To change the Working Directory, select your folder of choice in the file list  and then click on the
Set Working Directory toolbar icon. Alternatively, right-click  a folder of your choice in the Chirascan
Viewer launchpad file list  and choose Set Working Directory Here.

File names are defined in the File Names dialog (Figure 89) which is opened through the Chirascan
Control toolbar  and similar to the File Names tab  in the Preferences dialog .

Figure 89: The File Names dialog

On the File Names dialog, seed names for spectra and backgrounds can be set. In a series of
experiments, the file names will share the chosen seed name and be appended by an automatically
incremented number (four digits with leading zeroes) as set in the corresponding input fields.

Which file name input field is used depends on the measurement mode. The names specified in the
Spectra, Kinetics and Spectra-Kinetics input fields are used for the corresponding sequencing
modes . The name specified in the Background field is used when acquiring a background . The
remaining input fields are used only in conjunction with corresponding accessories . Note that
entering special characters (i.e., any of the following: */?;:.,"|=<>) is not allowed.

100

100

100

104

100

98 92 88

79 70

52



121

Chirascan V100 User Manual 
 
                                                                                                                    © 2023 Applied Photophysics Limited

Software

If you have performed operations  in Chirascan Viewer (e.g. smoothing, averaging or baseline-
subtraction), added comments , or altered the data in any other way, you may want to save the
results of the manipulation.
 
The manipulated data are not saved automatically. To save the result, go to Save All..., Save Current
Plot... or Save Selected Traces... on the File menu  to call up the Save As dialog. This saves the
active plot, the visible traces or the selected traces, respectively, in the Graphical Display , including
all settings and data.

If a new name is entered in the File Name input field, the plot will be saved under that name. If an
existing name is entered, you will be asked to confirm to over-write the original file. 

Complete information about the manipulated traces, including acquisition settings , remarks  and
History of data manipulation , is saved with a Datastore, and can be viewed on the Datastore Details
view  at the bottom of the launchpad  and by choosing DataStore Info..., Remarks... or History...
in the View menu .

8.3.5.2 Exporting Data

Data can be exported to various formats for use with other Applied Photophysics products or third-party
software. Right-click  on a Datastore in the file list  and choose Export Data... to bring up the
Export Data dialog (Figure 90). 

Figure 90: The Export Data dialog

Choose an appropriate format from the drop-down list for export to another program. Comma-Separated
Values (CSV) format is suitable for use with third-party programs such as Microsoft Excel™; whereas
the ProDataCSV format includes header information with measurement settings and remarks as well as
complete multi-dimensional data, the SimpleCSV format lacks header information and includes only
one-dimensional data. Other options relate to formats derived from other Applied Photophysics products.

Multiple Datatores can be exported at once with the Data Converter program. Start the program by
clicking its desktop shortcut. Click the Options... icon to open the Options dialog (Figure 91), set the
required options, and close the dialog. Select the files in the Launchpad File List , and drag them onto
the APL Pro-Data Converter window. Created files will be saved in the same folder as the originals.
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Alternatively, you can also select files in Windows Explorer and drag them onto the APL Pro-Data
Converter window.

Figure 91: The APL Pro-Data Converter window

Data from temperature ramp experiments  can be exported to separate files for each temperature and
wavelength by right-clicking  on a Datastore in the file list  and choosing Temperature Ramp
Data... to bring up the Extract temperature ramp data dialog which allows to choose from different
output formats.

8.3.6 The Launchpad Menu Bar

8.3.6.1 The File Menu

The File menu (Figure 92) gives access to the usual Microsoft Windows options for opening and closing
files:

· New creates an instance of the Graphical Display  with an empty plot.
· Open... opens the Datastore selected in the launchpad. Only a single Datastore is opened at a time.
· Delete deletes one or multiple Datastores selected in the launchpad.
· Rename allows renaming the selected Datastore.
· Exit closes Chirascan Viewer, including all open instances of the Graphical Display .

Figure 92: The File menu
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8.3.6.2 The View Menu

The View menu (Figure 93) gives access to the following functions:

· Close All Viewer Windows is a quick means of closing all instances of the Graphical Display . It
is useful if Single Window in the Preferences menu  has not been selected.
· Always On Top is a toggle to force Chirascan Viewer to be the top window. 

Figure 93: The View menu

8.3.6.3 The Directory Menu

The Directory menu (Figure 94) gives access to the following functions:

· Move Root Directory Up One Level moves the current directory up one level.
· Set Working Directory defines the current directory as the current Working Directory .
· Back to Working Directory returns you to the current Working Directory .
· New Folder creates a new folder in the current directory.
· Browse for Folders… opens a dialog allowing you to navigate to a specific directory.

Figure 94: The Directory menu

8.3.6.4 The Preferences Menu

The Preferences menu (Figure 95) is used to set the conditions for the graphics display and on-line
status and gives access to the following functions:

· Single Window when selected means that whenever a new instance of the Graphical Display  is
opened during data acquisition, the previous one is closed. If it is not selected, then whenever a new
measurement is made, the previous tab will remain open. If you are running an experiment that
involves a lot of measurements, it is recommended that Single Window be selected; if not, you could
end up with a large number of instances. Single Window has no effect when opening files from the
file list.
· Go On-line… will display the Connect... dialog (Figure 96) on which you will be asked to supply the

Chirascan IP Address. It is used when Chirascan Viewer has been started as a stand-alone program
and you want subsequently to establish a link with the SCP . If the two programs are running on the
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same computer, select Local in the Connect… dialog. The IP address under these circumstances is
always the default 127.0.0.1. 
· Allow Cary Files allows files imported from some Agilent Cary series spectrometers to be plotted

using Chirascan Viewer.

Figure 95: The Preferences menu

The client-server architecture permits remote monitoring of measurements in progress. If a copy of
Chirascan Viewer is installed on a remote computer, establishing a client-server link by using the
Remote setting will enable you to follow a measurement on the second computer. 

The IP address of the Chirascan computer will not be the same as the default local IP address – your
network administrator will be able to inform you. If the address is correct and the instrument is running,
the Chirascan Viewer display panel will open. Chirascan Viewer will ‘listen’ to Chirascan Control and
report its status, behaving as a real-time display. If the address is incorrect, an error message will
appear.

Once the link between Chirascan Viewer and the SCP  has been established, Go On-line… will be
ticked and the Chirascan Viewer status bar  will read Ready (On-line).

Figure 96: The Connect... dialog

8.3.6.5 The Help Menu

The Help menu gives access to the following functions (Figure 97):

· Help… opens the user manual. You can browse the contents and search for specific words and
phrases.
· About Chirascan Viewer… opens the About Chirascan Viewer dialog, which gives the version

number and other information about Chirascan Viewer.
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Figure 97: The Help menu

8.3.7 The Graphical Display Menu Bar

8.3.7.1 The File Menu

The File menu (Figure 98) gives access to the usual Microsoft Windows options for opening, closing and
printing files:
 
· Save All... opens the Save As dialog that allows you to save  the active plot, including both visible

and hidden traces.
· Save Current Plot… saves  the active plot, including only visible traces.
· Save Selected Traces… saves  only the traces selected in the active plot.
· Copy to Clipboard copies the active plot for pasting into third-party software such as Microsoft Word.
· Export as High Resolution Image opens a dialog that allows exporting the active plot to a bitmap

with specified dimensions.
· Print... opens the Print dialog that allows printing the active plot.
· Close closes the active instance of the Graphical Display .

Figure 98: The File menu

Some of the options of the File menu are also accessible through the Standard toolbar  or the right-
click menu  of the Graphical Display .

8.3.7.2 The View Menu

The View menu gives access to the following functions (Figure 99):

· Aux Dimension Ctrl toggles visibility of the third-dimension slider bar when dealing with multi-
dimensional Datastores .
· Legend toggles visibility of the trace names that appear by default at the side of a plot.
· Grid toggles visibility of the grid lines in the active plot.
· Error opens a submenu that allows to set the display properties of the standard error .
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· DataStore Info… opens the DataStore Information dialog that shows general information  about
the displayed Datastore.
· Remarks… opens the Remarks and Comments dialog that shows custom user information  for

the displayed Datastore.
· History… opens the History dialog that shows a history  of the operations  performed on the

Datastore.

Note that Audit Trail… is a deprecated function.

Figure 99: The View menu

8.3.7.3 The Trace Menu

The Trace menu gives access to the following functions (Figure 100):

· Show Trace Name toggles visibility of the name of a highlighted trace when the mouse pointer is
placed near to it.
· Selection Dialog... opens up the Trace Manipulation dialog .
· Select All selects all traces in the active plot.
· Deselect All deselects all traces in the active plot.
· Remove Selected removes from the active plot any currently selected trace. Removed traces can be

recovered using the Trace Manipulation dialog .
· Remove Unselected Traces removes from the active plot any trace that is not selected. Removed

traces can be recovered using the Trace Manipulation dialog .
· Toggle Selected as Baseline sets / unsets a selected trace as a baseline.
· Add Baseline becomes enabled once a baseline has been set and adds the baseline to one or

multiple selected traces. It is useful if a baseline has been subtracted inadvertently from a trace.
· Subtract Baseline becomes enabled once a baseline has been set and subtracts the baseline from

one or multiple selected traces.
· Remove Overlaid Traces removes all overlaid traces .
· Recompute Trace Colours will assign new colors to the traces in the plot. This is useful if after trace

manipulation the colors of traces are not satisfactory.
· Reset will undo all operations carried out on the traces in the active instance of the Graphical Display

and restore the original display.
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Figure 100: The Trace menu

Some of the options of the Trace menu are also accessible through the Trace Manipulation dialog ,
the Analysis toolbar  or the right-click menu  of the Graphical Display .

8.3.7.4 The Math Menu

The Math menu gives access to the following functions (Figure 101):

· Fitting… opens the Curve fitting dialog enabling a model to be fitted  to a selected trace. 
· Average. calculates and plots the average of the selected traces.
· Average All Traces. calculates and plots the average of all the traces in the active plot. The original

traces are removed. Removed traces can be recovered using the Trace Manipulation dialog .
· Simple Math… opens the Simple Math dialog that enables you to apply simple calculations  on

traces.
· Smooth… opens the Smoothing – Savitsky-Golay dialog that allows you to apply a smoothing

algorithm to one or multiple selected traces.
· Convert… opens the Convert CD Units dialog enabling you to convert  from millidegress or delta A

to other CD units. 

Figure 101: The Math menu

Some of the options of the Math menu are also accessible through the Trace Manipulation dialog ,
the Analysis toolbar  or the right-click menu  of the Graphical Display .
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8.3.7.5 The Scale Menu

The Scale menu gives access to the following functions (Figure 102):

· Set Plot limits… calls up the Select Range dialog that enables you to set  the limits for the x-
and y-axes.
· Reset Zoom resets  the scale to the original display size.
· On-line Auto-scale toggles automatic scaling so that any traces are always fully visible.
· X Logarithmic toggles the scale of the x-axis between logarithmic and linear. This feature can be

useful when time is plotted on the x-axis, as is the case for kinetic data.

Figure 102: The Scale menu

8.3.7.6 The Window Menu

The Window menu gives access to the following functions (Figure 103):

· New Window… opens a list from which a desired property can be selected. The new window will be
displayed at the same time as the original window in a tile format. 
· Close closes the currently active instance of the Graphical Display .
· Cascade will display in a cascade format all property windows (e.g. CD, absorbance, HT) that have

been opened and are not currently minimized. 
· Tile will display in a tiled format all property windows (e.g. CD, absorbance, HT) that have been

opened and are not currently minimized.
· Arrange icons will tidy up any minimized property displays that have been strewn around the

Graphical Display .
· 1, 2 etc. refer to the open property windows: the displayed window is identified by the check icon.
· Windows… opens a dialog that allows activating a property window and closingor tiling property

windows selected from a list.
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Figure 103: The Window menu

8.3.7.7 The Help Menu

The Help menu gives access to the following functions (Figure 104):

· Help… opens the user manual. You can browse the contents and search for specific words and
phrases.
· About Chirascan Viewer… opens the About Chirascan Viewer dialog, which gives the version

number and other information about Chirascan Viewer.

Figure 104: The Help menu
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9 Tips and Tricks

This section provides limited supporting guidance and recommendations on how to use the Chirascan
V100 efficiently and might be most helpful for first-time users. If you need more comprehensive
resources or advice, please visit www.photophysics.com or contact  Applied Photophysics.

9.1 Choosing Acquisition Settings

In general, if you are not sure which acquisition settings to choose, i.e., if the wavelength positions of
spectral components or the maximum amplitude of the CD spectrum to be expected is unknown, then
perform a fast (using a short time-per-point and a larger step size), preliminary scan over the full
wavelength range. After establishing where the sample is CD-active and which sample concentration is
required for optimal absorbance, the settings can be adjusted for a more thorough acquisition.

The following advise on choosing acquisition settings refers to measurements in Circular Dichroism
mode, although other signals can be selected depending on the accessories fitted. 

Typical values for the acquisition settings that need to be configured  are summarized in Table 2. The
example values provided are typical for proteins, although proteins containing cofactors such as haems
may have wider wavelength ranges of interest. Other acquisition settings might need to be chosen
depending on the sample requirements.

Table 2: Typical values of acquisition settings for measuring CD spectra of proteins

Setting Typical Values

Wavelength range 260 nm to as low as possible (far-UV), 350 to 250 nm (near-UV)

Step size 1 nm (far-UV), 0.5 nm (near-UV)

Bandwidth 1 nm

Time-per-point 1 s

Repeats 3 or more

Temperature 20°C

9.1.1 Wavelength Range

The wavelength range of the Chirascan V100 is from 1150 to 163 nm, depending on the buffer and
cuvette path length. Most samples, including proteins, are only CD active over a fraction of this range,
typically between 350 nm and 180 nm. It may not be possible to cover the full range in a single scan
because of the variation of the CD signal amplitude with wavelength.

9.1.2 Step Size

The step size will determine the number of data points that make up a spectrum. For a given time-per-
point, larger step sizes will reduce the overall scan time of an experiment but will also reduce the
resolution of the spectrum; smaller step sizes will improve the resolution of a spectrum, but will increase
the experimental time. An appropriate step size can be chosen using Equation 5: 

step size = peak width / 20 (5)

where the peak width refers to the full width at half height (in nm) of the narrowest peak in the spectrum.
If this is unknown, for samples in solution the step size is typically set between 0.2 nm and 1 nm. A
lower step size of 0.5 nm is typically used for proteins in the near-UV, where the spectra are more
detailed than in the far-UV. 

147
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9.1.3 Bandwidth

The bandwidth should be selected to maximize the light reaching the sample, without overly
compromising the spectral resolution or photolyzing the sample. In general, the signal-to-noise ratio ,
S/N, is proportional to the square root of the light throughput, and the light throughput is proportional to
the square of the bandwidth. Consequently, S/N is linearly proportional to the bandwidth. Doubling the
bandwidth will reduce the noise level by a factor of 2, tripling the bandwidth will reduce the noise level by
a factor of 3, and so on. 

However, a wider bandwidth may result in some of the finer details of the spectrum being obscured, and
there is a limit to the maximum bandwidth that can be set. This varies with wavelength because of the
non-linear dispersion of light by prisms: dispersion increases (and therefore maximum bandwidth
decreases) with decreasing wavelength. Maximum bandwidths at the shorter wavelengths vary slightly
between instruments.

The selected bandwidth is therefore a compromise between data quality and spectral resolution. At
longer wavelengths where the detector sensitivity is reduced, you may need to use higher bandwidths to
obtain a reasonable S/N. For most samples the bandwidth is typically set between 0.5 nm and 2 nm.

Usually, it is recommended to use a bandwidth ≤1 nm to ensure the detector is working within its linear
regime, especially as you go to the near-UV where samples absorb less light. With the sample in place,
the emulated detector HV should not drop below 200 V. If it does, reduce the bandwidth.

9.1.4 Time-per-Point

The time-per-point is the time taken for data sampling at each step. The longer the time taken, the better
the S/N. From Equation 6 the S/N is proportional to the square root of the time-per-point, so doubling the
time-per-point will reduce the noise level by a factor of √2, trebling the time-per-point will reduce the
noise level by a factor by a factor of √3, and so on. The chosen time-per-point will therefore be a
compromise between data quality and experimental duration, but as with the bandwidth, make sure that
you use a time-per-point that is short enough not to cause sample photolysis.

9.1.5 Repeats

Increasing the number of repeats has the same effect as increasing the time-per-point on the signal to
noise ratio, but using more than one repeat (typically 3) is helpful as it shows whether the sample is
stable, for example it could be undergoing photolysis. Using more than one repeat also gives an
indication of the data spread at each wavelength. If you want to perform a statistical analysis of the data,
then several scans (typically 5) are recommended.

9.2 Experimental Design

This section describes how to design a CD measurement and optimize the experimental conditions to
obtain high-quality data. The actual operation of the spectrometer is described in previous sections.
Though this section focuses on proteins, the approach to making a good CD measurement is the same
for other samples, although the settings may be different.

9.2.1 The Importance of the Absorbance

The simple rule of making an efficient CD measurement is not to allow the absorbance to be too high. As
CD spectroscopy is an absorbance technique, the CD signal is linear with sample concentration only if
total sample absorbance obeys the Beer-Lambert law. If the total absorbance, including that of the

133
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solvent or buffer, is much above about 2 AU, then the light level is too low and reliable CD measurements
cannot be made.

9.2.1.1 The Signal-to-noise Ratio

The most important factor when designing a CD experiment is the signal-to-noise ratio, S/N. For any
measurement made using electronic equipment, there are always two parts to the response. One part is
the signal, which is the “true” part of the response, due to the sample. The other is the superimposed
random part, the “noise”, due to the irregular emission of photons from a light source and the irregular
movement of electrons in electrical circuitry. The noise can never be eliminated, although it can be
reduced by good instrument and experimental design. The important consideration is not the actual
noise level, but the ratio of the signal to the noise. For CD measurements, this is given by [W.C Johnson
in Circular Dichroism and the Conformational Analysis of Biomolecules, ed. G.D. Fasman, Plenum,
1996, pp 635 to 652]:

S/N ∝ (I
0
 · Q · t · 10-A)0.5 ΔA (6)

where I
0
 is the intensity of the incident light, Q is the quantum efficiency of the detector (i.e. the fraction

of incoming photons that produce electrons), t is the sampling time, A is the absorbance and ΔA is the
difference in absorbance between L- and R-CP light as given in Equation 6.

9.2.1.2 Optimal Absorbance

Equation 6 maximizes when A = log10 exp(2) ≈ 0.87, which is therefore the optimal absorbance for
making CD measurements. Figure 105 shows the S/N as a function of wavelength, normalized to a
maximum of 1. The S/N is greater than 0.8 over the range between about 0.4 to 1.6, and the absorbance
should be within this range for as much of the spectrum as possible. There is insufficient light to make
CD measurements when the absorbance is much above about 2 AU.

Figure 105: Signal-to-noise ratio as a function of absorbance.
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9.2.2 Measuring the Absorbance

To obtain the total absorbance of a buffer or sample, a reference measurement in air is required
beforehand. To this end, a background is recorded with the cuvette holder (and adaptor for short path
length cuvettes or demountable cells, if necessary) in place, but with no cuvette. The background
measurement must be performed over the same or a broader wavelength range as that used for the buffer
or sample.

9.2.3 Adjusting the Absorbance

The Beer-Lambert law (Equation 7) is used to adjust the sample concentration, the buffer type, and the
cuvette path length to give an absorbance that is appropriate for a given sample.

ΣA = Σ(ε ∙ c) ∙ l (7)

where ε is the extinction coefficient of each species, c is the concentration of that species, l is the path
length, and the summation sign Σ indicates that the contributions of all the species present are added
up. 

This means that the total absorbance can be adjusted:

· by changing the buffer and hence ε for the buffer (e.g., by dialysis).
· by changing the path length (i.e., using a different cuvette).
· by changing the concentration of the buffer or the sample (i.e., by concentrating or dilution).

The extinction coefficient of the sample cannot be changed, as that would mean changing the sample.
To obtain a high CD signal, the sample must be sufficiently concentrated, but to keep the total
absorbance low enough, the buffer absorbance must be as low as possible. To meet both these criteria,
a short path length cuvette is used, preferably with a low absorbance buffer, and the sample
concentration is adjusted to give the optimum absorbance.

9.2.3.1 Optical Pathlength

Standard cuvettes are available in path lengths from 0.5 mm to 10 mm. For CD measurements in the far-
UV region (< 260 nm), 0.5 or 1 mm path length cuvettes are recommended, as water and aqueous
buffers absorb strongly in this region, particularly at low wavelengths, and short path length cuvettes are
used to keep the buffer absorbance low.

In the near-UV region (> 260 nm) the choice of path length is usually less limited because water and
most buffers do not absorb strongly in this region. However, near-UV measurements are typically
performed with longer path lengths to account for the lower signal that can be expected in this
wavelength range. Therefore, a 5 mm or 10 mm path length cuvette is typically used. Specially designed
cuvettes must be used if fluorescence measurements are intended; these normally have path lengths of
at least 2 mm.

Applied Photophysics recommends using CD or CD/fluorescence cuvettes from Hellma GmbH,
Müllheim, Germany, or Starna Group, Hainault, United Kingdom.

For more information about cuvettes compatible with the Chirascan V100, please consult the Cuvettes
and Holders Selection Guide available in the Accessories section on the Applied Photophysics website.

https://www.photophysics.com/systems/chirascan-systems/chirascan/accessories/
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9.2.3.2 Buffer Absorbance

Buffer components can contribute to the total absorbance and this contribution is usually stronger at
lower wavelengths. Moreover, the wavelength range in which the absorbance is suitable can be limited by
excipients that are CD-active such as histidine or Triton X-100. If in such a case the total absorbance is
too high even at low path length, one might want to consider dialysis of the sample against a different
buffer that has a lower absorbance.

Moreover, if a buffer contains CD-active compounds, it is recommended to dialyze samples against this
buffer and use the dialysate for baseline correction to ensure that any buffer contribution to CD spectra is
subtracted accurately.

Table 3 shows the absorbance cut-off for some common buffers in a 0.5 mm path length cuvette. At
wavelengths lower than the cut-off, the absorbance of the buffer is greater than 1 AU.

Even if an aqueous sample does not contain any excipients, buffer components or salt, absorbance by
the water itself can be limiting. If you wish to go below 180 nm, consider using heavy water (D

2
O): it

absorbs less in this region than normal water and is not expensive: buy NMR-standard D
2
O from a

reputable supplier. If you wish to go to 170 nm or even lower—and these can be somewhat difficult
experiments to perform—you will have to employ a cell with a path length of ≤0.1 mm and use heavy
water.

Table 3: Absorbance cut-off of some common buffers

Buffer path length Cut-off (A > 1 AU)

D
2
O

0.1 mm
171 nm

Water 175 nm

D
2
O

0.5 mm

174 nm

Water 178 nm

20 mM pH 7
Phosphate

181 nm

10 mM NaF 180 nm

10 mM NaCl 185 nm

1% DMSO 220 nm

100 mM Tris 190 nm

100 mM MES 201 nm

100 mM
HEPES

209 nm

100 mM
PIPES

210 nm

9.2.3.3 Sample Concentration

In the far-UV region, proteins have an extinction coefficient of about 7000 M-1 cm-1, where M refers to the
concentration of peptide bonds. For a 0.5 mm path length cuvette, this means that the protein
concentration should be about 0.2 to 0.4 mg/ml. In the near-UV region, the absorbance of proteins
depends mainly on the concentrations of the aromatic amino acids, particularly tryptophan. This results
in an optimal concentration ranging from about 0.45 mg/ml for proteins with a high tryptophan content,
such as lysozyme which has 6 tryptophan residues and a molecular weight of about 14 kD, to more than
2.5 mg/ml for molecules with a much lower tryptophan content.
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9.2.3.4 Summary

It is not possible to cover all contingencies, but the guidelines covered in this section provide at least a
starting point in helping you to find the optimal experimental conditions. In a nutshell, consider the
following points for adjusting the absorbance for CD measurements:

1. If possible, use a buffer that does not absorb strongly in the wavelength range of interest.
2. If necessary, use a shorter path length cuvette and increase the sample concentration accordingly.
3. Adjust the sample concentration to keep the total absorbance below 2 AU and centered on about

0.9 AU.

Measuring the CD spectra of proteins is the most common use of the Chirascan V100. Conditions
recommended to ensure that protein CD spectra are of the highest quality even at very low wavelengths
are given in Table 4.

Table 4: Recommended conditions for measuring protein CD spectra

Lower wavelength limit Solvent path length Protein Concentration

180 nm Dilute buffer, H
2
O or D

2
O ≤ 0.5 nm 0.2 - 0.5 mg/mL

175 nm H
2
O or D

2
O ≤ 0.2 nm 0.5 - 1.0 mg/mL

170 nm D
2
O ≤ 0.1 nm 1.0 mg/mL
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9.3 Example Spectra

There are several files installed on the hard disk that can be used as templates to set up the Chirascan
interface or as tools to familiarize oneself with the use of Chirascan Viewer . The files are held in the
\Examples subfolder of the Chirascan software directory and can be accessed in Chirascan Viewer
by navigating to this directory in the file list .

9.3.1 Alcohol Dehydrogenase

The CD spectrum of 1 mg/mL alcohol dehydrogenase dissolved in water using a 0.1 mm path length
cuvette, plotted as CD (mdeg) against wavelength (nm), is shown in Figure 106. The acquisition settings
are given in Table 5.

Figure 106: CD spectrum of alcohol
dehydrogenase

 
Table 5: Acquisition settings for the spectrum in
Figure 106

Setting Value

Wavelength range 260 nm to 175 nm

Step size 0.5 nm

Bandwidth 1 nm

Time-per-point 3 s

Repeats 1

9.3.2 Bovine Serum Albumin

The CD spectrum of 1 mg/mL bovine serum albumin dissolved in water using a 0.1 mm path length
cuvette, plotted as CD (mdeg) against wavelength (nm), is shown in Figure 107. The acquisition settings
are given in Table 6.

Figure 107: CD spectrum of bovine serum
albumin

 
Table 6: Acquisition settings for the spectrum in
Figure 107

Setting Value

Wavelength range 260 nm to 175 nm

Step size 0.5 nm

Bandwidth 1 nm

Time-per-point 3 s

Repeats 1
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9.3.3 Cytochrome C

The CD spectrum of 1 mg/mL cytochrome C dissolved in water using a 0.1 mm path length cuvette,
plotted as CD (mdeg) against wavelength (nm), is shown in Figure 108. The acquisition settings are
given in Table 7.

Figure 108: CD spectrum of cytochrome C

 
Table 7: Acquisition settings for the spectrum in
Figure 108

Setting Value

Wavelength range 260 nm to 175 nm

Step size 0.5 nm

Bandwidth 1 nm

Time-per-point 3 s

Repeats 1

9.3.4 Lysozyme

The CD spectrum of 0.2 mg/mL lysozyme dissolved in water using a 0.5 mm path length cuvette, plotted
as CD (mdeg) against wavelength (nm), is shown in Figure 109. The acquisition settings are given in
Table 8.

Figure 109: CD spectrum of lysozyme

 
Table 8: Acquisition settings for the spectrum in
Figure 109

Setting Value

Wavelength range 260 nm to 185 nm

Step size 0.5 nm

Bandwidth 2 nm

Time-per-point 1 s

Repeats 3
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9.3.5 Vitamin B12

The CD spectrum of 0.2 mg/mL vitamin B12 dissolved in water using a 1 mm path length cuvette, plotted
as CD (mdeg) against wavelength (nm), is shown in Figure 110. The acquisition settings are given in
Table 9.

Figure 110: CD spectrum of vitamin B12

 
Table 9: Acquisition settings for the spectrum in
Figure 110

Setting Value

Wavelength range 600 nm to 200 nm

Step size 1 nm

Bandwidth 1 nm

Time-per-point 2 s

Repeats 1

9.3.6 Tris(ethylenediamine) Cobalt Chloride

The CD spectrum of 1 mg/mL tris(ethylenediamine) cobalt chloride dissolved in water using a 10 mm
path length cuvette, plotted as CD (mdeg) against wavelength (nm), is shown in Figure 111. The
acquisition settings are given in Table 10.

Figure 111: CD spectrum of tris(ethylenediamine)
cobalt chloride

 
Table 10: Acquisition settings for the spectrum in
Figure 111

Setting Value

Wavelength range 800 nm to 250 nm

Step size 1 nm

Bandwidth 1 nm

Time-per-point 0.5 s

Repeats 1
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9.3.7 Camphor Sulphonic Acid

The CD spectrum of 0.6 mg/mL 1-S-camphor-10-sulphonic acid dissolved in water using a 1 mm path
length cuvette, plotted as CD (mdeg) against wavelength (nm), is shown in Figure 112. The acquisition
settings are given in Table 11.

Figure 112: CD spectrum of camphor sulphonic
acid

 
Table 11: Acquisition settings for the spectrum in
Figure 112

Setting Value

Wavelength range 300 nm to 180 nm

Step size 0.5 nm

Bandwidth 0.5 nm

Time-per-point 1.75 s

Repeats 1

9.3.8 (R)-3-Methylcyclopentanone

The CD spectrum of vaporous (R)-3-methylcyclopentanone using a 10 mm path length cuvette, plotted
as CD (mdeg) against wavelength (nm), is shown in Figure 113. The acquisition settings are given in
Table 12.

Figure 113: CD spectrum of (R)-3-
methylcyclopentanone

 
Table 12: Acquisition settings for the spectrum in
Figure 113

Setting Value

Wavelength range 350 nm to 175 nm

Step size 0.1 nm

Bandwidth 0.1 nm

Time-per-point 1 s

Repeats 1
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10 Maintenance and Servicing

10.1 General Maintenance

Applied Photophysics recommends that the instrument is serviced regularly. This is best achieved by
holding a Support Plan. Please contact  Applied Photophysics Customer Support for further advice on
Support Plans.

The spectrometer has been calibrated by Applied Photophysics engineers during production or servicing.
Recalibration by the user is not recommended, except under instruction from an Applied Photophysics
Customer Support Specialist.

If used and maintained with care, the Chirascan V100 spectrometer should provide many years of
reliable service. 

Do not allow aggressive or corrosive chemicals to come into contact with the
Chirascan V100 as these may cause damage to the instrument: clean up any
spillages immediately. To clean the instrument, use a soft cloth with a dilute
solution of mild detergent in water.

Clean the in-sample temperature probe  after use with, for example, isopropyl alcohol. Do not use
aggressive or corrosive chemicals such as strong acids to clean the temperature probe.

The lamp  should be replaced  within the recommended 1000-hour lifetime, if it becomes difficult to
ignite, gives unstable output, or if if the output is diminished. It is recommended to also replace the
nitrogen filter  once a lamp replacement becomes necessary.

10.2 Cleaning cuvettes

Applied Photophysics recommends cleaning cuvettes with multiple water rinses, followed by an acetone
rinse, before finally blow-drying with nitrogen gas.
Compressed air can be used as long as it is clean and free of contaminants.
For mildly persistent contaminants, Applied Photophysics recommends the use of detergents such as
Hellmanex.
For heavily persistent contaminants, Applied Photophysics recommends soaking cuvettes in
concentrated nitric acid for 1-24 hour(s). 

10.3 Moving the Instrument

The spectrometer is heavy and should only be moved manually if enough
people are available to support its weight , using lifting handles provided.

The spectrometer has designated lift points and lifting at the wrong points can
result in damage to the instrument. Do not attempt to lift or move the
spectrometer except under guidance from Applied Photophysics Customer
Support.

The monochromator has components than can be damaged if their movement
is not restricted when the spectrometer is moved. This movement is restricted
by parking the monochromator.

147
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Never alter height of the monochromator leveling feet, as this may impair light
path alignment. Height adjustment of the three adjustable feet beneath the
sample chamber should not be necessary under normal operation of the
system, including usage of the Chirascan Stopped-Flow accessory. Upon
sample chamber re-installation, the sample chamber and monochromator
should align precisely after tightening the sample chamber thumb screws.
Only adjust height of the sample chamber feet if the latter happens not to be
the case. This can be done by turning the bolts of the feet with a 13 mm
spanner (clockwise to decrease height / anti-clockwise to increase height).

To park the monochromator, open the Monochromator dialog through the Device window , and click
Park mono. Exit the software and switch off the electronics without any further actions once the parking
completes. Any adjustment of wavelength, bandwidth or attenuator will unpark the monochromator.
Restarting the electronics will also unpark the monochromator as the instrument goes through its
initialization sequence. Power should only be restored when the instrument is settled in its new location.

After moving or relocating the instrument, the spectrometer can be leveled by using a spirit level and
adjusting feet height, including monochromator leveling feet. However, this should only be done by
Applied Photophysics engineers as otherwise instrument alignment may be impaired. 

Applied Photophysics Customer Support should be contacted  for any further guidance or assistance
with relocation.

94
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10.4 Lamp Removal and Replacement

The xenon arc lamp operates at mains voltage. Power off the lamp before
removal.

The light source of the Chirascan V100 is a 150-watt xenon or mercury-xenon
arc lamp that produces intense UV radiation that can be harmful to skin and
eyes and may even impair eyesight permanently. Do not allow the skin to be
exposed to UV radiation. Never look directly at the light source. Do not power
on the lamp unless it is correctly mounted in the lamp housing. Do not remove
the lamp system cover and do not open the lamp housing while the lamp is
operative, as indicated by the yellow lamp system cover indicator. Do not
attempt to remove the UV filter of the lamp housing port. Do not attempt to
remove the Single Cell Peltier Holder or any accessory that replaces it unless
the lamp is powered off or the lamp shutter is closed.

Xenon arc lamps have a high internal pressure and can burst, particularly when
hot, causing injury to the user and bystanders. Do not open the lamp housing
immediately after it is powered off. Handle carefully, do not submit the lamp to
shock, and wear eye, full face (shield / visor), and body protection, including
full arm covering. Do not touch the glass bulb of the lamp with bare hands.
When handling lamps, ensure that others are restricted from entering the area
or wear protective personal equipment as well. If not installed, always store
and transport lamps (old or new) only in safety metal cases provided by
Applied Photophysics to guard against implosion.

The lamp is at high temperature during operation. Do not remove outer lamp
system cover while the lamp is on. Surface temperature of the lamp unit
housing exceeds 50°C during operation, imposing risk of burns, DO NOT
TOUCH. After powering off, allow lamp housing temperature to decrease until
cool to touch (at least 30 minutes) before removing the lamp.

When changing a lamp, remember that the programmed schedules for the
ANMS will remain active. Do not power on a Xenon or Mercury-Xenon lamp
until the lamp spectrometer has been thoroughly purged.

When reconnecting the red and black power leads of the lamp, ensure that
they are not being connected the wrong way around.

To change a lamp, follow the steps below, referring to Figure 114.

First, remove the currently installed lamp:

1. Have an empty lamp storage box ready to receive the old lamp.
2. Shut down the computer and switch off the system by putting the black rocker switch for the System

on the front panel  to the power off (O) position.
3. Switch off the lamp power supply by putting the black rocker switch for the Lamp on the front

panel  to the power off (O) position, and leave for at least 30 minutes for the lamp to cool down. 
4. Unscrew the two thumbscrews at the back of the spectrometer that connect its end cover to the left

with the back cover.
5. Remove the spectrometer end cover by sliding it to the left, off the magnetic catches and clear of the

lamp housing.
6. Unplug the red and black leads at the back of the lamp power supply.

40

40
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7. Unscrew the two retaining screws on top of the lamp assembly.
8. Carefully lift the old lamp out of the housing and place in the storage box, securing with the retaining

screws.

Figure 114: Lamp housing fittings with lamp cover removed

Then, install the new lamp:

9. Unscrew the retaining screws from the new lamp storage box, remove the lamp, and carefully insert
into the housing.

10.Secure the lamp in the housing with the retaining screws.
11.Reconnect the red and black leads, replace the spectrometer end cover and screw in the

thumbscrews connecting it to the back plate.
12.Switch on the lamp power supply and the system with the corresponding black rocker switches on

the front panel , start the computer and open the ANMS  software.
13.Click Start Lamp Ignite Sequence in the ANMS  software and reset the timer on the system

front panel .
14.Please return the old lamp assembly to Applied Photophysics for recycling.

40 65

65

40
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10.5 Troubleshooting

If the instrument does not operate properly, please use Table 13 to eliminate any trivial causes of
incorrect function.

Table 13: Troubleshooting 

Symptom Cause Corrective Action

Instrument /
computer cannot be
powered on.

No power available.

Check that all power cables are correctly plugged in.

Check that the power at the mains outlet is powered on.

Check that all supply fuses are intact.

Communications
between instrument
and software failing.

Communications cable
loose or broken.

Check that the USB cable connecting instrument and
computer is correctly plugged in.

Check that the USB cable connecting instrument and
computer is intact.

Correct startup procedure
was not followed or
instrument has been
powered off before closing
down software.

Unplug and replug USB cable connecting instrument and
computer.

Close down and restart software. Power up hardware
before launching software.

No detector signal.

No light - lamp is not
ignited.

Set the lamp ignition sequence on the ANMS or choose
Lamp Immediate Start if the instrument has been purged
for a sufficient time. 

No light - shutter is in the
closed position.

Use the Chirascan interface to Open the shutter or
enable Autoshutter function.

No light – slits too narrow
or closed.

Check the bandwidth in the Monochromator panel of the
Chirascan interface and set the bandwidth to a
reasonable value, e.g. 1 nm

No light – sample is
opaque.

Reduce concentration and / or path length of sample
and / or buffer.

No light in far-UV –
instrument is not purged.

Oxygen absorbs light at wavelengths below 190 nm.
Ensure that the purge tubes are connected at both ends
and that there is nitrogen available, and purge the
instrument with clean nitrogen.

Signal is too noisy.

Bandwidth too narrow
Check the bandwidth in the monochromator section of
the Chirascan interface and set it to a reasonable value,
e.g. 1 nm.

Sample or buffer is highly
absorbing.

Reduce concentration and / or path length of sample
and / or buffer.

Lamp is old.
If the lamp has been run for more than 1,000 hours, its
output, especially in the far-UV, will be low. Replace
lamp.

Unstable line voltage Use stabilized supply.

Electromagnetic
interference from nearby
equipment.

Remove the source of noise from the proximity of the
spectrometer.
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10.6 Contact Information

If the instrument does not operate properly and the observed issue is either not covered in
Troubleshooting  or symptoms persist after consulting this section, please contact Applied
Photophysics Customer Support using the details below, with a detailed description of your issue and
the name of your spectrometer. Each spectrometer has a serial number that can be found inside the
sample chamber .

By telephone

UK & international:
US:

By e-mail

All inquiries:

+44 1372 386 537
+1 978 473 7477

support@photophysics.com 

Moreover, feel free to contact Applied Photophysics Customer Support if you have any doubts about
instrument usage or need additional information or special assistance regarding:

· Relocating the instrument
· Queries relating to the software or PC
· Preventative Maintenance and Support Plans
· Consumables, replacement parts and upgrades
· Training and applications support
· Compatibility with accessories or third-party equipment
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Applied Photophysics Inc.
2331 Crownpoint Executive Drive, Suite F

Charlotte, NC 28227
United States

Tel.: +1 978 473 7477
Email: info.usa@photophysics.com

Applied Photophysics Ltd.
21 Mole Business Park
Leatherhead, Surrey, KT22 7BA
United Kingdom

Tel.: +44 1372 386 537
Email: info@photophysics.com

Head Office US Office
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